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1 Представляем EssentialPIM Pro

Добро пожаловать в EssentialPIM Pro!

EssentialPIM Pro является профессиональным инструментом управления
персональной информацией. Он возьмет на себя напоминание о встречах и
делах, хранение контактов и заметок в удобной для использования форме. 

Pro версия значительно превосходит более простую EssentialPIM Free версию,
поднимая функциональность на абсолютно иной уровень. Среди наиболее
значительных функций EssentialPIM Pro можно отметить:

Многопользовательский доступ к базе данных*
Хранение файлов, либо ссылок на них
Назначение исполнителей (из числа контактов) к делам
Продвинутое резервное копирование данных
Редактируемые категории в делах и задачах
Иерархическая структура дел и заметок
Группы контактов
Отправка любой записи по электронной почте
Синхронизация с устройствами на базе Android, iOS
Синхронизация с Outlook
Синхронизация с Google, SyncML и CalDAV серверами, а также многими
другими онлайн сервисами
Возможность создания и работы с массовыми почтовыми рассылками

...и множество других функций.

* - требуется бизнес лицензия.

1.1 Основные функции

EssentialPIM Pro - это полнофункциональный менеджер персональной
информации, основными функциями которого являются:

Удобство и простота использования. Расширенные клавишные комбинации
увеличат вашу скорость работы и эффективность. 
Безопасность. Все данные могут быть зашифрованы несколькими
алгоритмами шифрования, такими как: AES (Rijndael), 128-битный ключ или
Blowfish, 448-битный ключ.
Широкие возможности экспорта и импорта. Вы можете импортировать и
экспортировать в следующие форматы HTML, RTF, CSV, TXT и TreePad. Вы
можете осуществить полную синхронизацию с Microsoft Outlook, с
устройствами на Android, iOS, WinMobile и Palm, а также с сервисами Google,
iCloud, Yahoo, Toodledo, CalDAV, SyncML и другими
Возможность прикреплять к данным EPIM внешние файлы или ссылки, и
хранить всё в одной базе.
Возможность удобно посылать данные по любой записи используя email.
Удобное автоматическое резервное копирование.
Использование базы с открытым исходным кодом - Firebird. Опытные
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пользователи и системные администраторы оценят возможности гибкой
настройки и доступность множества инструментов администрирования баз
данных.

2 Лицензионное соглашение

EssentialPIM Pro(tm) License Agreement. 

EssentialPIM Pro is SHAREWARE. 

ASTONSOFT EssentialPIM Pro VERSION 2 END-USER LICENSE AGREEMENT 

IMPORTANT-READ CAREFULLY: This EssentialPIM Pro End-User License Agreement
("EULA") is a legal agreement between you (either an individual or a single entity)
and Astonsoft Ltd., for the EssentialPIM SOFTWARE(s) identified above, which
includes the User's Guide, any associated SOFTWARE components, any media, any
printed materials other than the User's Guide, and any "online" or electronic
documentation ("SOFTWARE"). By installing, copying, or otherwise using the
SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to
the terms of this EULA, do not install or use the SOFTWARE. If the SOFTWARE was
mailed to you, return the media envelope, UNOPENED, along with the rest of the
package to the location where you obtained it within 30 days from purchase. 

1. The SOFTWARE is licensed, not sold. 

2. GRANT OF LICENSE. 

(a)   Evaluation Copy. You may use the SOFTWARE without charge on an evaluation
basis for thirty (30) days from the day that you install the SOFTWARE. You must pay
the license fee and register your copy to continue to use the SOFTWARE after the
thirty (30) days. If you continue to use the SOFTWARE after the thirty (30) days
without paying the license fee you will be using the SOFTWARE on an unlicensed
basis.

(b)   Redistribution of Evaluation Copy. If you are using SOFTWARE on an evaluation
basis you may make copies of the evaluation SOFTWARE as you wish; give exact
copies of the original evaluation SOFTWARE to anyone; and distribute the evaluation
SOFTWARE in its unmodified form via electronic means (Internet, BBS's, Shareware
distribution libraries, CD-ROMs, etc.). You may not charge any fee for the copy or
use of the evaluation SOFTWARE itself, but you may charge a distribution fee that is
reasonably related to any cost you incur distributing the evaluation SOFTWARE (e.g.
packaging). You must not represent in any way that you are selling the SOFTWARE
itself. Your distribution of the evaluation SOFTWARE will not entitle you to any
compensation from Astonsoft. You must distribute a copy of this EULA with any copy
of the SOFTWARE and anyone to whom you distribute the SOFTWARE is subject to
this EULA. 

(c)   Registered Copy. After you have purchased the license for SOFTWARE, and
have received the file enabling the registered copy, you are licensed to copy the
SOFTWARE only into the memory of the number of computers corresponding to the
number of licenses purchased. The primary user of the computer on which each
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licensed copy of the SOFTWARE is installed may make a second copy for his or her
exclusive use on a portable computer. Under no other circumstances may the
SOFTWARE be operated at the same time on more than the number of computers for
which you have paid a separate license fee. You may not duplicate the SOFTWARE in
whole or in part, except that you may make one copy of the SOFTWARE for backup
or archival purposes. You may terminate this license at any time by destroying the
original and all copies of the SOFTWARE in whatever form. You may permanently
transfer all of your rights under this EULA provided you transfer all copies of the
SOFTWARE (including copies of all prior versions if the SOFTWARE is an upgrade) and
retain none, and the recipient agrees to the terms of this EULA. 

3. RESTRICTIONS. You may not reverse engineer, de-compile, or disassemble the
SOFTWARE, except and only to the extent that such activity is expressly permitted
by applicable law notwithstanding this limitation. You may not rent, lease, or lend the
SOFTWARE. You may permanently transfer all of your rights under this EULA,
provided the recipient agrees to the terms of this EULA. You may not use the
SOFTWARE to perform any unauthorized transfer of information (e.g. transfer of files
in violation of a copyright) or for any illegal purpose. 

4. SUPPORT SERVICES. Astonsoft may provide you with support services related to
the SOFTWARE. Use of Support Services is governed by the Astonsoft polices and
programs described in the user manual, in online documentation, and/or other
provided materials, as they may be modified from time to time. Any supplemental
SOFTWARE code provided to you as part of the Support Services shall be considered
part of the SOFTWARE and subject to the terms and conditions of this EULA. With
respect to technical information you provide to Astonsoft as part of the Support
Services, Astonsoft may use such information for its business purposes, including for
product support and development. Astonsoft will not utilize such technical
information in a form that personally identifies you. 

5. TERMINATION. Without prejudice to any other rights, Astonsoft may terminate
this EULA if you fail to comply with the terms and conditions of this EULA. In such
event, you must destroy all copies of the SOFTWARE. 

6. COPYRIGHT. The SOFTWARE is protected by United States copyright law and
international treaty provisions. You acknowledge that no title to the intellectual
property in the SOFTWARE is transferred to you. You further acknowledge that title
and full ownership rights to the SOFTWARE will remain the exclusive property of
Astonsoft and you will not acquire any rights to the SOFTWARE except as expressly
set forth in this license. You agree that any copies of the SOFTWARE will contain the
same proprietary notices which appear on and in the SOFTWARE. 

7. EXPORT RESTRICTIONS. You agree that you will not export or re-export the
SOFTWARE to any country, person, entity, or end user subject to U.S.A. export
restrictions. You warrant and represent that neither the U.S.A. Bureau of Export
Administration nor any other federal agency has suspended, revoked or denied your
export privileges. 

8. NO WARRANTIES. Astonsoft expressly disclaims any warranty for the SOFTWARE.
THE SOFTWARE AND ANY RELATED DOCUMENTATION IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OR MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, OR NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT OF
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USE OR PERFORMANCE OF THE SOFTWARE REMAINS WITH YOU. 

9. LIMITATION OF LIABILITY. IN NO EVENT SHALL Astonsoft OR ITS SUPPLIERS BE
LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT
DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, PERFORMANCE, OR USE OF
THE SOFTWARE, EVEN IF Astonsoft HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN ANY EVENT, Astonsoft'S LIABILITY FOR ANY CLAIM, WHETHER IN
CONTRACT, TORT, OR ANY OTHER THEORY OF LIABILITY WILL NOT EXCEED THE
GREATER OF U.S.$1.00 OR LICENSE FEE PAID BY YOU. 

10. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE is provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data
and Computer SOFTWARE clause of DFARS 252.227-7013 or subparagraphs (c)(i) and
(2) of the Commercial Computer SOFTWARE-Restricted Rights at 48 CFR 52.227-19,
as applicable.

3 О справочном пособии

Данное справочное пособие призвано познакомить вас с функциями и приемами
работы с EssentialPIM Pro. Для более удобной подачи информации в тексте
используется ряд условных обозначений, которые представлены ниже.

Жирным шрифтом в тексте обозначены элементы интерфейса так как они
написаны в программе. К примеру, диалоговые окна, вкладки, кнопки, о которых
идет речь, либо которые надо нажать.

Полезный прием, упрощающий работу с описываемой выше функцией,
либо полезные клавиатурные сочетания  для быстрого доступа к
функции.

Информация к сведению пользователя на которую следует обратить
внимание.

Особо важная информация, обязательная к исполнению для корректной
работы программы.

4 Работа с EssentialPIM Pro

Ниже представлены модули которые включает в себя EssentialPIM Pro.
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Модуль Сегодня представляет
собой обобщенный вид событий
на ближайшие дни из нескольких
модулей программы. Подробнее...

Календарь является
центральной частью программы
EssentialPIM Pro и служит для
планирования и контроля
событий. В зависимости от
текущих задач, календарь может
отображаться в различных
режимах Подробнее...

Модуль Дела является мощным
инструментом для создания
списков дел различной степени
сложности. EssentialPIM Pro
позволяет выстроить дела в
иерархическую структуру,
разделять на отдельные списки,
использовать различные
категории. Подробнее...
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Заметки представляют собой
удобный инструмент для
хранения и ведения ежедневных
записей. Инструментарий модуля
предлагает не только
стандартный набор функций
текстового редактора, но и
позволяет организовать заметки
в иерахическую структуру,
разделять на отдельные списки и
даже прикреплять отдельные
заметки на рабочий стол в виде
липких листочков. Подробнее...

Модуль Контакты является
мощным инструментом для
хранения, и управления
контактами. EssentialPIM Pro
предоставляет в распоряжение
пользователя инструменты по
группировке и редактированию
записей, созданию почтовых
рассылок по различным группам
контактов, созданию и печати
конвертов и этикеток. 
Подробнее...

Модуль Почта представляет
собой полноценный почтовый
клиент, с классическим набором
инструментов, с поддержкой как
IMAP так и POP3 протоколов,
почтовых фильтров, не
ограниченного количества
учетных записей, PGP
шифрования и прочих функций. 
Подробнее...
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Модуль Пароли представляет
собой хранилище и менеджер
данных учетных записей для
различных сервисов.
Инструментарий модуля
позволяет хранить детали
учетных записей, генерировать
пароли, упорядочивать записи по
группам, что делает его
незаменимым помощником в
ежедневной работе. Подробнее...

4.1 Работа с файлами баз данных EPIM Pro

4.1.1 Запуск программы

Первый запуск

При первом запуске EssentialPIM Pro создает тестовый файл test.epim,
содержащий примеры записей которые можно создавать в программе. Можно как
продолжить работу с этим файлом, так и создать новый в меню Файл -> Новый
-> Файл базы данных EPIM
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При создании новой базы данных EssentialPIM Pro создает временный файл вида
temp.32B51682.epim. Для завершения создания файла следует его сохранить
воспользовавшись командой Файл -> Сохранить/Сохранить как, либо
подтвердить сохранение при закрытии базы или программы. При сохранении
файлу рекомендуется присвоить какое-нибудь значимое имя отличное от
временного во избежание путаницы в будущем.

Следует заметить, что слово "test" в названии файла не означает, что
данный файл, либо программа работают в тестовом режиме. Это лишь
имя файла, которое может быть изменено.

Последующие запуски

EssentialPIM Pro запоминает последний файл с которым вы работали и открывает
его автоматически при следующем старте программы. Программа также хранит
список из трех последних открывавшихся файлов. Его можно найти в меню Файл
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Этим меню можно воспользоваться для быстрого доступа к последним файлам, а
также для быстрого поиска вашего файла, если EssentialPIM по какой-то
причине не открыл файл автоматически.

Открытие любой базы данных EssentialPIM Pro возможно также через меню Файл
-> Открыть, где в проводнике надо указать расположение требуемого *.epim
файла.

По умолчанию EssentialPIM Pro хранит файлы баз данных в
нижеследующих папках:
C:\Documents and Settings\User Name\Application Data\EssentialPIM Pro\ -
для XP
C:\Users\User_name\AppData\Roaming\EssentialPIM Pro\ - для Vista, 7 и 8
Данные папки не являются обязательными для хранения баз данных
EssentialPIM Pro. Используемые файлы могут быть перенесены в любое
удобное для пользователя место на жестком диске и открыты в
программе.

При использовании нескольких *.epim файлов можно создать ярлыки по
которым EssentialPIM Pro будет принудительно открывать нужный файл.
Для этого в свойствах ярлыка программы в поле Объект через пробел
надо дописать путь к требуемому *.epim файлу.

Параметры запуска и работы EssentialPIM Pro

EssentialPIM Pro может запускаться как вручную через ярлык, так и
автоматически при старте Windows. Программа также может следить чтобы было
открыто не больше одной копии программы. Эти и другие параметры могут быть
установлены в настройках Сервис -> Настройки -> Общие.
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Сворачивать в трей - окно программы сворачивается системный трей (фон) а
не на панель задач при минимизации окна.
Кнопка Закрыть как Свернуть - программа сворачивается на панель задач при
попытке её закрыть. Так можно быть уверенным, что ни одно напоминание не
будет пропущено из-за случайного закрытия программы.
Автозагрузка с Windows - автоматически запускает EssentialPIM Pro при
старте системы.
Только одна активная программа EssentialPIM - при попытке запустить
дополнительную копию программы, активируется уже запущенная копия.
Автоматическая проверка обновлений - если включено, раз в несколько
дней EssentialPIM автоматически проверяет наличие обновлений. Можно также
проверить обновления вручную нажав кнопку Проверить.
Форматы даты и времени - позволяет установить, либо системные настройки
даты и времени (установленные в региональных настройках Windows), либо
установить один из предлагаемых форматов даты даты. Можно также ввести
свой формат вручную в соответствии с маской ввода.
Вид при старте программы - позволяет установить какой модуль загружать на
старте.
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При одновременной активации параметров Сворачивать в трей и
Автозагрузка с Windows может возникнуть ситуация, когда значок
EssentialPIM Pro оказывается среди скрытых значков системной панели
и создается впечатление, что программа не запущена. В таких случаях
при попытке запустить программу новая копия выдает ошибку, что
требуемый файл данных занят, что является верным, так как файл
действительно занят уже работающей программой. Чтобы избежать
подобной ситуации надо включить постоянное отображение значка
EssentialPIM Pro в настройках системной панели Windows. Либо в
дополнение активировать опцию Только одна активная программа
EssentialPIM. В этом случае, иконка программы всегда будет на виду,
случайная попытка запуска второй копии EssentialPIM Pro будет
активировать уже работающую копию программы из трея.

Shift+Ctrl+S - глобальное сочетание клавиш, вызывающее из трея и
сворачивающее в трей окно программы.

4.1.2 Архивация данных

Обеспечение сохранности пользовательских данных является неотъемлемой
частью функционала EssentialPIM Pro. Для этого, помимо регулярного
автосохранения данных, в программе предусмотрена система архивации
(резервного копирования) данных. Это практически полностью исключает
потерю данных в любых обстоятельствах. По умолчанию, EssentialPIM создает
резервные копии файла данных в той же папке где расположен сам *.epim файл.
Это параметр, как и ряд других, можно изменить в настройках через меню 
Сервис -> Настройки -> Архивы.

Включить архивацию - включает/отключает создание резервных копий. Мы
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настоятельно не рекомендуем отключать этот параметр, иначе в случае какого-
либо сбоя восстановление данных может быть очень затруднено.
Создать архив - немедленно создает резервную копию, независимо от
установленного расписания.

Папка для архивов - этот блок позволяет указать куда сохранять резервные
копии. Можно сохранять в папку где находится база данных (по умолчанию), в
стандартную папку для временных файлов Windows, либо указать любую
удобную папку на жестком диске, для этого нажмите кнопку Обзор и укажите
необходимую папку.

Интервал архивации - позволяет установить частоту архивации в часах.
Число хранимых архивных копий - позволяет установить число хранимых
архивов прежде чем они будут перезаписаны более новыми.

При указании папки для создания резервных копий следует указывать
папку на локальном диске. EssentialPIM не может сохранять файлы на
сетевых дисках, либо сетевых хранилищах (NAS).

Типы архивов и файлов, создаваемые EssentialPIM

my_database.epim – стандартный файл данных EssentialPIM, созданный
пользователем (новый файл всегда можно создать через меню Файл -> Новый -
> Файл данных EPIM). Путь к открытому в данный момент файлу можно найти 
в заголовке окна программы, либо через меню Файл -> Управление базой
данных.

my_matabase.backup_20130118_1401.epim – стандартная резервная копия
созданная в соответствии с параметрами архивации. Числа в названии
обозначают дату (в формате ггггммдд) и время (в 24-х часовом формате)
создания архива. Для экономии места на жестком диске, архивы создаются в
сжатом виде, поэтому  они могут быть существенно меньше основного файла
данных. Чтобы восстановить данные из архива нужно просто открыть архив в
программе как обычный файл через меню Файл -> Открыть.

При переносе данных на другой ПК, достаточно скопировать основной
файл данных и открыть его в EssentialPIM. Необязательно осуществлять
перенос данных через резервную копию.

restored.my_database.epim – файл восстановленный из архива. Мы
рекомендуем переименовывать (достаточно удалить слово "restored." из имени)
файл после восстановления, чтобы избежать возможной путаницы в именах
будущих архивов.

backup_convert_200130118_1521.epim.bak – данный тип файлов создается
при переходе на новую версию программы. EssentiaPIM создает резервную
копию базы данных перед тем как сконвертировать ее в новый формат для новой
версии. В случае если что-то пойдет не так в процессе обновления, всегда
можно вернуться к предыдущей версии файла. Можно попытаться открыть его
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снова, либо открыть в предыдущей версии программы. Чтобы открыть файл
данного типа, надо сначала удалить расширение ".bak", а затем открыть как
стандартный файл через меню Файл -> Открыть. Предыдущие версии
EssentialPIM'a можно скачать отсюда.

4.1.3 Обслуживание базы данных

В нормальных условиях EssentialPIM автоматически выполняет все необходимые
действия по обслуживанию файла базы данных. Тем не менее, некоторые
действия могут быть выполнены вручную, если возникнет такая необходимость.
Ниже рассмотрено, что можно сделать с файлом вручную, и какие результаты
получить после этого.

Оптимизация базы данных

Эта процедура оптимизирует базу данных удаляя некоторую устаревшую
служебную информацию, что делает файл данных меньше по размеру и в
некоторых случаях ускоряет работу программы. Запустить оптимизацию можно
через меню Файл -> Управление базой данных -> Оптимизация.
Оптимизация базы является профилактической мерой и в обычных условиях
EssentialPIM выполняет ее автоматически, когда для этого выполняется ряд
установленных условий, другими словами, когда возникает такая
необходимость.

Прежде чем запускать оптимизацию базы данных убедитесь, что в
данный момент нет активного процесса синхронизации, либо получения/
отправки почты. В случае, если таковые имеются, кнопка Оптимизация
будет неактивной. Чтобы остановить процессы, нажмите кнопку 
Остановить все в окне статуса синхронизации, или получения почты.

Архивирование старых данных

Когда база данных используется достаточно долго, вполне очевидно, что в ней
может накопиться некоторое количество старых и уже не актуальных данных.
Удаление старых данных сделает базу данных меньше и, возможно, улучшит
производительность. Для этой задачи у нас есть бесплатная дополнительная
программа - EPIM Arhiver/DupeRemover. EPIM Arhiver может произвести
следующие действия:
- Переместить старые записи в Корзину для текущей базы данных
- Переместить записи в отдельный файл для последующего хранения
- Удалить старые записи
Более подробную информацию по использованию EPIM Archiver/DupeRemover
можно найти в справке самой программы.

Удаление дубликатов

EPIM Archiver/DupeRemover может быть также использован и для поиска и
удаления дубликатов. Программа сканирует все модули на предмет дубликатов,
после чего выдает список с результатами. По умолчанию предлагается удалить

https://essentialpim.zendesk.com/hc/en-us/articles/200843832-EssentialPIM-Pro-older-versions
http://www.essentialpim.com/ru/pc-version/supplementary-apps
http://www.essentialpim.com/ru/pc-version/supplementary-apps
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все найденные дубликаты, но также есть возможность вручную указать какие
записи удалять, а какие нет. Все удалённые записи помещаются в корзину,
откуда их можно удалить окончательно, либо восстановить.

Для работы программы должна быть соблюдена совместимость версий с
EssentialPIM. Основной номер версии EPIM Archiver/DupeRemover'a и
EssentialPIM'a должны совпадать. Например, EPIM Archiver/DupeRemover
версии 5.5 будет работать с файлом EssentialPIM'a версии 5.53, но не
будет работать с файлом созданным в EssentialPIM 4.5.

4.2 Основной вид EssentialPIM Pro

EssentialPIM Pro включает в себя множество функций для управления
персональными данными. В то же время большинство из них интуитивно понятны
благодаря простому интерфейсу. Данное руководство описывает приемы
эффективной работы с программой, чтобы вы могли легко и удобно
организовывать и синхронизировать данные.

Ниже представлено рабочее окно EssentialPIM Pro:

Секция 1: Главное меню программы. Оно содержит все команды для управления
программой. Содержимое меню может меняться в зависимости от активного в
данный момент модуля.
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Секция 2: Панель навигации, она позволяет переключаться между модулями и
видами внутри модулей. Панель навигации может быть представлена в
свернутом либо развернутом виде. Переключение между видами панелей
осуществляется при помощи кнопки вверху панели.

Набор используемых модулей можно настроить тут: Сервис ->
Настройки -> Модули, либо используя контекстное меню, кликнув по
панели правой кнопкой мыши.

Секция 3: Календарь, который может использоваться для поиска не занятого
дня, а также для быстрой навигации.

В области календаря можно включить несколько месяцев, для этого
надо расширить область календаря, перетащив выше линию между
календарем и панелью модулей, удерживая левую кнопку мыши.

Секция 4: Панель инструментов, позволяет совершать различные действия с
записями текущего модуля. Инструментарий панели инструментов разнится в
зависимости от активного модуля.

Секция 5: Главное окно модуля, его вид меняется в зависимости от активного,
в данный момент, модуля.
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4.3 Сегодня

Модуль Сегодня представляет собой обобщённый вид событий на ближайшие
дни из нескольких модулей программы. Рабочая область окна разделена на
четыре блока:

Календарь - показывает список ближайших событий из модуля Календарь. По
умолчанию список состоит из событий на три дня.
Дела - аналогично разделу календарь, показывает список дел на ближайшие
дни (по умолчанию на три дня).
Письма - показывает в каких учетных записях и в каких папках есть
непрочитанные письма.
Годовщины - здесь отображаются события которые EssentialPIM Pro генерирует
автоматически из полей c форматом "дата" в контактах. По умолчанию это дни
рождения. Более подробно о полях формата "дата" можно узнать тут.

Настройка модуля Сегодня

Модуль Сегодня зачастую используется как сводка важных событий на
ближайшее время, поэтому очень важно, чтобы в списке были все важные
события, и в то же время, чтобы список не был завален ненужными, либо
второстепенными записями. Для этого EssentialPIM Pro предлагает набор
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настроек, позволяющих гибко настроить модуль Сегодня под требуемые задачи.
Настройки модуля находятся тут - Сервис -> Настройки -> Сегодня.

Настройки разделены на три раздела, каждый из которых отвечает за
соответствующий блок в модуле Сегодня. Чекбокс возле названия включает/
отключает показ соответствующего блока.  
Запускать EPIM на форме Сегодня - при включенной опции, EssentialPIM
стартует с модуля Сегодня, если опция отключена, то EssentialPIM запускается
на том модуле, который был отрыт при закрытии программы.
Список Задач на - позволяет установить задачи за какой промежуток
показывать в модуле Сегодня.
Список Дел с началом или сроком выполнения на (дней вперед) -
показывает дела которые начинаются, либо заканчиваются в ближайшие Х дней.
Показывать списки дел без дат - показывает/прячет дела в которых не
введены даты начала и конца.
Не показывать выполненные Задачи/Дела - показывает/скрывает записи,
которые отмечены как выполненные.
Показать Задачи/Дела для выбранных категорий - позволяет выбрать
записи с какими присвоенными категориями показывать в модуле Сегодня.
Показывать выбранные папки - позволяет выбрать какие папки показывать в
блоке Письма.
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Показывать Годовщины - включает/отключает раздел с годовщинами.

Следует иметь ввиду, что настройки модуля Сегодня не влияют на
настройки отображения событий в самих модулях Календарь и Дела,
равно как и наоборот. Поэтому, если в модуле Сегодня отсутствует то
или иное событие, убедитесь, что оно соответствует параметрам
отображения модуля Сегодня.

4.4 Календарь

4.4.1 Pабота с календарем

Календарь является центральной частью программы EssentialPIM Pro и служит
для планирования и контроля событий. В зависимости от текущих задач,
календарь может быть включен в различных режимах (День, Неделя, Месяц,
План недели, Год, Таблица). Переключаться между ними можно через меню
Вид, либо с помощью панели навигации слева.

День/Неделя

Два этих режима являются идентичными, с той лишь разницей, что первый
показывает задачи на определенный день, а второй на неделю.
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Основную часть рабочей области занимает временная сетка, позволяющая
легко ориентироваться в уже созданных задачах, находить свободное время, а
также создавать новые задачи на нужное время. Задачи, имеющие время начала
и конца в течении одного дня, находятся внутри сетки, задачи длительностью
целый день и больше отображаются в верхней части календаря сразу под датой.

Слева находится шкала времени масштаб которой можно изменить через меню
Вид -> Масштаб, либо через контекстное меню:

Рабочее время в сетке отмечено более светлым цветом, входные дни - красным
шрифтом. Изменить рабочее время и ряд других параметров отображения
календаря можно в настройках модуля Календарь.
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Месяц/Год

Режимы Месяц и Год также идентичны по функциональности. Данные режимы
являются удобным инструментом для управления событиями на
продолжительные периоды времени.

План недели

Данный режим является сочетанием недельного и месячного видов. Он сочетает
в себе наглядность месячного вида и достаточно большой объем отображаемой
информации недельного. В итоге получается наглядная сводка событий на
неделю.
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Таблица

В некоторых случаях, когда требуется более детальный анализ задач,
классических видов календаря может оказаться не достаточно. Для этого в
EssentialPIM Pro есть табличный вид календаря. В этом режиме задачи и дела,
отображаемые в календаре, представлены списком в виде таблицы.

Такой режим позволяет работать с событиями практически также как в
табличном процессоре. Все параметры могут быть изменены напрямую в ячейках
таблицы. 

Вверху над таблицей можно указать границы дат, в рамках которых следует
отображать события. При отключенном чекбоксе возле параметров дат, в
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таблицу будут включены все события календаря. 

Любой столбец может быть отключен, либо включен через контекстное меню
заголовка таблицы.

Записи таблицы могут быть отсортированы по одному или нескольким столбцам,
для этого надо щелкнуть левой кнопкой мыши по заголовку столбца, значок
стрелочки в заголовке столбца показывает порядок сортировки, второй щелчок
меняет порядок сортировки на противоположный. Для сортировки по нескольким
столбцам надо при щелчке по заголовкам столбцов удерживать клавишу Ctrl.

Для быстрого переключения между видами календаря можно
воспользоваться следующими комбинациями горячих клавиш:
Ctrl+D - День
Ctrl+W - Неделя
Ctrl+M - Месяц
Ctrl+R - Год
Ctrl+E - Таблица

Сортировка и фильтрация

EssentialPIM Pro позволяет настроить режимы отображения календаря под
необходимые нужды. К примеру, можно включить/выключить отображение
событий определенных категорий. Для этого надо зайти в меню Вид ->
Показывать категории.
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Затем, либо включить/отключить категории в данном меню по одной, любо
выбрать пункт Выбрать и указать необходимый набор категорий для
отображения.

Если календарь показывает пользовательский набор категорий, то это
отражается на панели просмотра.

Различные фильтры, применённые к текущему виду, отображаются отдельными
элементами на панели просмотра. Каждый из этих элементов можно отключить,
кликнув на него, и нажав Удалить. 

Любой набор фильтров можно сохранить как шаблон и затем возвращаться к
нему при необходимости через меню шаблонов в правой части.
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Данное меню позволяет легко переключаться между сохраненными шаблонами.

Настроить список шаблонов в меню можно нажав на пункт Выбор шаблонов в
меню шаблонов.

Панель просмотра можно отключить или включить воспользовавшись
соответствующей опцией в меню Вид.

Настройки календаря

Для большего удобства использования календаря, EssentialPIM Pro позволяет
изменить ряд настроек. Окно настроек открывается через меню Сервис ->
Настройки -> Календарь.
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Рабочее время - позволяет настроить время начала и конца рабочего дня. Этот
отрезок будет иметь более светлый оттенок в календаре.
Показывать только рабочие часы - скрывает/показывает не рабочие часы в
дневном и недельном видах.
Автовыбор часовой шкалы - растягивает разметку календаря на всю рабочую
область экрана, если по умолчанию отображаемые часы не занимают все
пространство рабочей области
Рабочая неделя - аналогично рабочим часам позволяет отметить какие дни
недели считать рабочими.
Показывать только рабочие дни - скрывает/показывает выходные дни.
Первый день недели - позволяет установить какой день недели будет первым
в недельном и месячном видах.
Число дней в просмотре недели - устанавливает сколько дней показывать в
недельном виде. Можно установить от трех до четырнадцати дней.
Число недель в просмотре месяца - устанавливает сколько недель
показывать в месячном виде. Можно установить от двух до десяти недель.
Данная функция может быть полезной когда нужно высвободить место в ячейках
дней для большого количества записей, либо когда требуется иметь перед
глазами отрезок времени больший чем один месяц.
Число месяцев в году - устанавливает сколько месяцев показывать в годовом
виде. Можно установить от 1 до 48 месяцев.
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В режиме таблицы помнить введенные вручную даты - запоминает
диапазон дат установленных в табличном виде.
Показывать для задач... - данное выпадающее меню позволяет скрыть
отображение времени начала, либо конца встречи, либо обоих. Это позволяет
сэкономить место и показать больше текста из названия события.
Лунный календарь - включает китайский лунный календарь.
Показывать категории - определяет в каком виде показывать категории в
табличном виде (не влияет на остальные виды).
Показывать сетку - включает/выключает сетку ячеек в табличном виде.
Цвет фона - позволяет установить цвет фона, который будет взят за основу во
всех режимах календаря кроме табличного.

Дата и время

Время в календаре может отображаться в 12-и и 24-х часовом формате, также
поддерживаются различные форматы даты. Настроить формат даты и времени
можно через меню - Сервис -> Настройки -> Общие 

При включенном параметре Использовать системные, EssentialPIM Pro
использует формат даты на основе региональных настроек Windows. Их можно
настроить тут - Пуск -> Панель Управления -> Язык и региональные
настройки.

4.4.2 Добавление задачи

Добавить новую задачу можно несколькими способами. Один из способов
нажать на кнопку Новая Задача на панели инструментов, либо через меню
Действия -> Новая Задача.

Можно также создавать задачи прямо в календаре следующими способами:
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Удерживая левую кнопку мыши выделите временной отрезок необходимый для
события, затем отпустите кнопку, это откроет окно создания/редактирования
задачи с уже заполненными полями начала и окончания. В окне можно ввести
остальные данные, такие как тема, категория, заметки и прочие.

Двойной клик по любой точке в календаре создает задачу в данной точке и
откроет окно создания/редактирования задачи.

Для быстрого ввода задачи на определенное время можно просто кликнуть один
раз в нужной точке календаря и начать вводить тему задачи, при этом будет
создана новая задача аналогично предыдущему способу, но при этом не будет
открыто окно редактирования задачи.

Shift+Ctrl+T - глобальное сочетание клавиш для добавления новой
задачи (работает даже когда окно программы не активно в данный
момент)
Задачу также можно добавить через меню Файл -> Новый -> Задача

4.4.3 Редактирование задачи

Задачи могут быть отредактированы в любой момент. При двойном клике по
задаче открывается диалог Свойства задачи.
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Начало - время начала задачи.
Конец - время окончания задачи.
Длительность - автоматически вычисляет длительность задачи; длительность
можно также указать вручную, в этом случае будет автоматически подсчитано
время окончания задачи.
Тема - название задачи которое отображается в календаре.
Место - можно выставить место в котором планируется выполнение задачи.
Последние значения сохраняются в выпадающем меню. Вы можете добавить,
удалить или настроить положение пунктов данного списка, нажав на пункт 
Управление местоположениями.

Статус - данный параметр позволяет поменять статус задачи с публичного на
приватный.
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Весь день - задачи с данным параметром не имеют времени начала и конца,
они занимают целый день и отображаются в верхней части календаря. 
Особая - эксклюзивность задачи в течении установленного для задачи
времени. Другая задача не сможет быть добавлена на это же время.
Приоритет - изменение приоритета задачи.
Выполнение - позволяет выставить уровень завершенности задачи.
Категория - позволяет назначить категорию для задачи. Можно также
создавать пользовательские категории. Более подробно с управлением
категориями можно знакомиться в теме Категории.
Текст - здесь можно добавить дополнительную информацию о задаче. В случае
если поле Тема не заполнено,  вместо него используется текст заметок для
отображении на разметке различных календарных видов.
Связанные записи - в этой вкладке показаны записи в которых есть ссылка на
данную задачу.
Теги - здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.

Ряд параметров, таких как Категория, Приоритет, Статус и
Выполнение, можно изменять используя контекстное меню выделенной
задачи, либо через меню Правка.

Напоминания

Напоминание включается выбором времени напоминания в выпадающем меню в
разделе Напомнить:

Напоминание может быть выставлено либо непосредственно на время события (0
минута), либо заранее.

Нажав на кнопку Добавить напоминание можно добавить дополнительное
напоминание к задаче.
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Удалить напоминание можно нажав на крестик около напоминания.

Нажав кнопку Настройки можно также установить дополнительные параметры
напоминания:

Диалог дополнительных настроек позволяет установить звуковое сопровождение
для напоминания, это может быть как Стандартный звук, так и Звук из файла
в формате *.wav или *.mp3.
В блоке Сообщение можно выставить Специальное сообщение для
напоминания.
Можно также назначить выполнение программы вместе с напоминанием, для
этого нужно указать путь к запускаемому файлу программы через кнопку Обзор
в блоке Запуск программы.

Повторение задачи

EssentialPIM Pro позволяет создавать серии повторяющихся задач. Для
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включения повторений требуется активировать соответствующий чекбокс - 
Повторять каждые:

Можно установить ежедневное, еженедельное, либо ежемесячное повторение
задачи. Параметр Истекает позволяет установить дату окончания серии. Для
установки более сложного цикла повторений можно воспользоваться
дополнительными параметрами, нажав кнопку Настройки:
 

Данный диалог позволяет установить более сложный цикл повторений.
Например, как показано на иллюстрации выше, можно повторять задачу каждый
второй вторник месяца.

Чтобы не перегружать базу данных при создании бессрочных задач, по
умолчанию создается ограниченное количество повторений (для
каждого периода оно разное).

Шаблоны
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Для облегчения ввода однотипных задач EssentialPIM Pro позволяет создавать
шаблоны. Для создания шаблона нужно всего лишь создать новую задачу,
установить необходимые параметры, которые будут общими для задач данного
типа и нажать кнопку Сохранить как шаблон в левом нижнем углу окна
редактирования задачи, после чего будет предложено ввести название шаблона.

С временем начала и длительностью - данная опция включает время события
в шаблон. Таким образом подобный шаблон позволит быстро создавать
однотипные события в любой день на одинаковое время.

Как только шаблон сохранен, он появляется в выпадающем меню на той же
панели инструментов. Теперь, чтобы им воспользоваться, просто выберите его
из списка при создании новой задачи. Для управления шаблонами выберите
пункт Выбор шаблонов в выпадающем списке с шаблонами, после чего
откроется диалоговое окно где перечислены все созданные шаблоны. Здесь вы
можете поменять порядок, удалить либо переименовать шаблоны. 

Кнопки Вверх, Вниз, Удалить позволяют редактировать порядок списка и
удалять ненужные шаблоны. Кнопки По умолчанию и Сброс настроек
позволяют установить какой шаблон будет использоваться при создании новой
задачи.
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4.5 Дела

4.5.1 Работа со списками дел

Модуль Дела является мощным инструментом для создания списков дел
различной степени сложности. EssentialPIM Pro позволяет выстроить дела в
иерархическую структуру, разделять на отдельные списки, использовать
различные категории. Эти и другие функции делают легким и интуитивно
понятным управление как простыми списками, так и разветвленным проектами.

Добавление дела

Добавить дело в список можно несколькими способами. Самый простой способ
это нажать кнопку Добавить в корень на панели инструментов, это добавит
дело в корень активного в данный момент списка.

Чтобы создать Дочернее, либо  Одноуровневое дело, нажмите на кнопку со
стрелкой рядом с кнопкой Добавить в корень и выберите соответствующий
пункт. 

В первом случае будет создано дочернее дело по отношению к выделенному, а
во втором - дело будет добавлено на тот же уровень, что и выделенное в
данный момент дело. Новое дело можно также создать через меню Действия ->
Новое дело.

Еще один быстрый способ создать дело это двойной щелчок мыши по пустой
части рабочей области. При использовании любого из перечисленных способов
отрывается окно редактирования дела, в котором можно указать тему, время
начала и конца, категорию и прочие параметры. Более подробно параметры дела
рассмотрены в теме Редактирование дела.

Shift+Ctrl+O - глобальное сочетание для добавления нового дела
(работает даже когда окно программы не активно в данный момент)
Дело также можно добавить через меню Файл -> Новый -> Дело
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Создание списков

Самый простой способ упорядочить дела по темам - это разделение их на
списки. По умолчанию EssentialPIM Pro создает список под названием Список 1.
Чтобы добавить новый список, либо изменить уже имеющийся, нужно вызвать
контекстное меню списка щелкнув правой кнопкой мыши по его названию.

Переименовать - позволяет переименовывать текущий список.
Добавить - создает новый список.
Удалить - удаляет текущий список со всеми делами, содержащимися в нем.
Цвет - позволяет изменить фон закладки с названием списка.
Статус - позволяет установить статус списка - личный, либо публичный.
Только чтение - запрещает редактирование всех дел списка.

Списки дел можно перемещать между собой путем перетаскивания, удерживая
левую кнопку мыши.

Управление структурой дел в списке

Как уже говорилось выше, дела могут быть организованы в иерархическую
структуру. Структура уже созданного списка дел может быть с легкостью
отредактирована. Самый простой способ - это перетащить дела на требуемую
позицию, удерживая левую кнопку мыши. Во время перетаскивания курсор
будет подсвечивать на какую позицию попадет дело. Чтобы сделать дело
дочерним нужно перетащить его на название будущего родительского дела, как
только родительское дело станет подсвеченным, можно отпустить левую кнопку
мыши.

Перемещать дела можно также используя соответствующие кнопки на панели
инструментов.

Кнопки со стрелками перемещают выделенное дело в соответствующее
направление.
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Чтобы быстро свернуть, либо развернуть все ветки дел, можно воспользоваться
соответствующими кнопками на панели инструментов - Свернуть/Развернуть
все.

Позиция Дела в иерархической структуре может быть указана напрямую из окна
редактирования дела.

Данный раздел позволяет установить в каком списке должно находиться дело и
его место в структуре дел.

Для управления структурой дел можно также воспользоваться
следующими сочетаниями горячих клавиш:
Ctrl+Alt+Вправо - на уровень вниз
Ctrl+Alt+Влево - ну уровень вверх
Ctrl+Alt+Вверх - переместить вверх
Ctrl+Alt+Вниз - переместить вниз
Ctrl+Alt+С - свернуть все
Ctrl+Alt+Х - развернуть все

Дела в календаре

С делами также можно работать и в календаре. В правой части модуля
Календарь находится панель, которая показывает дела практически так же, как
и в основном модуле, за исключением столбцов и возможности сортировки.
Включить/Отключить панель дел в календаре можно через меню Вид -> Панель
дел.

Дела также могут быть помещены в сам календарь. Для этого в есть две
возможности:

Показывать в Календаре - в календаре создается запись, которая является
ярлыком на запись в модуле Дела. Работать с ней можно так же как и с
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задачей, при этом все изменения будут отражаться в родительском деле.
Включить данную опцию можно из контекстного меню дела, через меню 
Действия -> Показывать в Календаре, либо ее можно включить в диалоге
редактирования дела.

Сохранить как задачу - создает задачу в календаре с теми же параметрами,
что и дело. При этом, в отличие от функции Показывать в Календаре, связь с
родительским делом не сохраняется, и обе записи могут изменяться независимо
друг от друга.  Включить данную опцию можно из контекстного меню дела,
через меню Действия -> Показывать в Календаре.

Ctrl+К - горячее сочетание для функции Показывать в Календаре
Дело также можно переместить на нужную позицию в календарь
простым перетаскиванием удерживая левую кнопку мыши, это
равносильно включению опции Показывать в Календаре. При этом
следует учитывать, что время начала и конца может быть изменено, в
соответствии с положением дела на календарной сетке. 

Настройки модуля Дела

EssentialPIM позволяет изменить ряд настроек в модуле Дела. Раздел настроек
доступен через меню Сервис -> Настройки -> Дела.

Показывать категории - предлагает различные виды отображения категорий
дел. Увеличивает наглядность, а так же при необходимости позволяет
сэкономить место рабочей области сократив ширину поля категория.
Автоматически удалять завершенные - автоматически помещает
завершенные дела в корзину по истечении определенного срока. Возможный
диапазон от немедленного удаления до удаления через год.

4.5.2 Редактирование дела

Дела могут быть отредактированы в любой момент. Быстрое редактирование дел
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возможно напрямую в рабочей области модуля Дела. Для этого надо выделить
необходимую ячейку в таблице и сделать одиночный левый клик мыши, после
чего можно ввести/отредактировать данные. В нижней части рабочей области
экрана можно напрямую редактировать заметки выделенного дела, добавлять и 
вложения.

Для более детального редактирования, можно воспользоваться окном создания/
редактирования дела. Диалоговое окно открывается двойным кликом левой
кнопки мыши по делу.

Начало - время начала дела (может быть не заполнено).
Конец - время окончания дела (может быть не заполнено).
Показывать в календаре - создает запись в календаре, которая является
ярлыком на дело.
Тема - название дела.
Место - можно выставить место в котором планируется выполнение дела.
Последние значения сохраняются в выпадающем меню. Вы можете добавить,
удалить или настроить положение пунктов данного списка, нажав на пункт 
Управление местоположениями.
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Категория - позволяет назначить категорию для задачи. Можно также
создавать пользовательские категории. Более подробно с управлением
категориями можно знакомиться в теме Категории.
Приоритет - позволяет изменить приоритет.
Статус - данный параметр позволяет поменять статус дел с публичного на
приватный.
Только чтение - дело не может быть отредактировано когда включена эта
опция.
Выполнение - позволяет выставить уровень завершенности.
Текст - в этой закладке можно добавить дополнительную информацию о деле. В
случае когда поле Тема не заполнено, вместо него используется текст этой
вкладки.
Связанные записи - в этой вкладке показаны записи в которых есть ссылка на
данное дело. 
Теги - здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.

Ряд параметров, таких как Категория, Приоритет, Статус,
Выполнение и Только чтение можно изменять используя контекстное
меню выделенного дела, либо через меню Правка.

Дополнительные поля

В случае, когда стандартного набора полей не достаточно, EssentialPIM Pro
позволяет создавать дополнительные пользовательские поля. За это отвечает
вкладка Дополнительные поля в диалоговом окне редактирования дела.
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Для добавления поля надо зайти во вкладку Дополнительные поля и нажать
кнопку Добавить поле, после чего ниже появится новое поле. Кнопки со
стрелками и корзиной позволяют  изменить порядок полей в списке или удалить
ненужные если требуется.

Нажав на кнопку со стрелкой рядом с кнопкой Добавить поле, можно выбрать
тип данных дополнительного поля. 

Данный диалог позволяет выбрать тип поля.

Текст - содержит текстовые или цифровые данные.
Дата - содержит дату в соответствии с установленным форматом даты.
Список выбора - создает поле в виде выпадающего меню.

Кнопки Добавить и Удалить позволяют создать список значений выпадающего
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меню, а кнопки Вверх и Вниз отредактировать порядок значений в списке.

Да/Нет - также создает поле в виде выпадающего списка, но, в отличии от
списка выбора, имеет бинарный формат и может иметь только два значения.

Выпадающее меню Формат позволяет выбрать какая именно пара значений
будет использоваться. Нажав кнопку с тремя точками возле выпадающего меню,
можно добавить свою пару значений.

Флажок - создает чекбокс, который может быть либо включен, либо выключен.
Данное поле не имеет дополнительных настроек.

Следует иметь в виду, что дополнительное поле не может быть создано
только в одном деле. При создании поля оно появляется во всех делах. 

Напоминания

Напоминание включается соответствующим чекбоксом в блоке Напомнить:

Напоминание для дела выставляется на конкретное число и время.

Нажав кнопку Настройки можно также установить дополнительные параметры
напоминания:
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Диалог дополнительных настроек позволяет установить звуковое сопровождение
для напоминания, это может быть как Стандартный звук, так и Звук из файла
в формате *.wav или *.mp3.
В блоке Сообщение можно выставить Специальное сообщение для
напоминания.
Можно также назначить выполнение программы вместе с напоминанием, для
этого нужно указать путь к запускаемому файлу программы через кнопку Обзор
в блоке Запуск программы.

Повторение дела

EssentialPIM Pro позволяет создавать серии повторяемых дел. Для включения
повторений требуется активировать соответствующий чекбокс - Повторять
каждые:

Можно установить ежедневное, еженедельное, либо ежемесячное повторение
дела. Параметр Истекает позволяет установить дату окончания серии. Для
установки более сложного цикла повторений можно воспользоваться
дополнительными параметрами, нажав кнопку Настройки:
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Данный диалог позволяет установить более сложный цикл повторений.
Например, как показано на иллюстрации выше, можно повторять дело каждый
второй вторник месяца.

Следует иметь в виду, что EssentialPIM не создает сразу всю серию дел.
Новое дело из серии появляется только после того, как текущее
отмечено как завершённое.

Шаблоны

Для облегчения ввода однотипных дел, EssentialPIM Pro позволяет создавать
шаблоны. Для создания шаблона нужно создать дело, установить необходимые
параметры которые будут общими для дел данного типа и нажать кнопку 
Сохранить как шаблон в левом нижнем углу окна редактирования дела.
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С временем начала и длительностью - данная опция включает время события
в шаблон. Таким образом подобный шаблон позволит быстро создавать
однотипные дела в любой день на одинаковое время.

Как только шаблон сохранен, он появляется в выпадающем меню на той же
панели инструментов. Теперь, чтобы им воспользоваться, просто выберите его
из списка при создании нового дела. Для управления шаблонами выберите
пункт Выбор шаблонов в выпадающем списке с шаблонами, после чего
откроется диалоговое окно где перечислены все созданные шаблоны. Здесь вы
можете поменять порядок, удалить либо переименовать шаблоны. 

Кнопки Вверх, Вниз, Удалить позволяют редактировать порядок списка и
удалять ненужные шаблоны. Кнопки По умолчанию и Сбросить настроенный
позволяют установить какой шаблон будет использоваться при создании нового
дела.

4.5.3 Анализ дел

При работе с проектами неизбежно возникает необходимость отслеживания
выполнения текущих дел, анализа текущего состояния проектов. EssentialPIM
Pro предлагает мощный, легко настраиваемый инструментарий для решения
данных задач.

Режимы просмотра дел

В первую очередь, для анализа сложных списков дел могут понадобиться
различные режимы отображения дел. EssentialPIM Pro предоставляет четыре
основных режима просмотра - Дерево, Простой, Сводный и подвид По сроку
выполнения. Переключаться между ними можно при помощи соответствующих
кнопок на панели навигации либо через меню Вид.
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Дерево - отображает дела с сохранением древовидной структуры.
Простой - в этом режиме игнорируется иерархия, но все дела отображаются в
своих списках.
Сводный - игнорирует списки, все дела из всех списков отображается одним
общим списком.
По сроку выполнения - разбивает дела по секциям: Просроченные, Без даты
окончания, Сегодня, Завтра, На этой неделе и т.д. Каждая секция может быть
свернута/развернута, при этом сохраняется древовидная структура дел.

Горячие сочетания для переключения между видами:
Ctrl+T - дерево
Ctrl+D - сводный
Ctrl+E - простой

Настройка основного вида

EssentalPIM Pro позволяет настроить набор отображаемых колонок в рабочей
области модуля Дела.

Кликните правой кнопкой мыши по заголовку таблицы, чтобы вызвать меню в
котором можно включить/отключить колонки.
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Выбрав пункт Настроить, в появившемся окне можно настроить набор
отображаемых колонок из всех доступных.

Если требуется изменить порядок колонок, то их можно перетащить на нужные
позиции удерживая левой кнопкой мыши. Иконка со стрелочкой показывает куда
будет помещена перетаскиваемая колонка.

EssentalPIM Pro запоминает настройки колонок для каждого листа (вкладки).
Для быстрого копирования настроек на другие листы можно воспользоваться
пунктом меню Применить к....

Сортировка и фильтрация

Еще одним важным инструментом анализа дел является возможность поиска и
сортировки дел по различным критериям. EssentalPIM Pro предлагает
разнообразный инструментарий по сортировке и фильтрации списков различной
степени сложности.  

Самый простой способ - это сортировка дел по колонкам. Для этого надо
щелкнуть левой кнопкой мыши по заголовку столбца по которому требуется
провести сортировку. В результате чего дела будут отсортированы по
возрастанию, при этом у заголовка столбца появится значок стрелочки, которая
показывает порядок сортировки. Второй щелчок меняет порядок сортировки на
противоположный. Для сортировки по нескольким столбцам при щелчке на
названия столбцов следует удерживать клавишу Ctrl.
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Для поиска либо фильтрации дел по одному ключевому слову, можно
воспользоваться строкой поиска в правом верхнем углу окна.

Нажав на значок лупы, можно указать поле, по которому следует провести
поиск.

Для фильтрации дел сразу по нескольким столбцам и критериям, EssentialPIM
Pro предлагает воспользоваться режимом фильтра. Чтобы перейти в этот режим,
нажмите кнопку Фильтр на панели Действия, в результате чего у заголовка
каждого столбца появится выпадающее окошко фильтра.

Данное окно содержит все значения, встречающиеся в текущем столбце.
Галочками можно отметить значения, которые требуется отобразить в списке.
Если значений очень много, то можно воспользоваться строкой поиска в верхней
части окна. Как только все значения отмечены, можно нажать кнопку ОК для
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применения фильтра. Щелчок мыши за пределами окна равносилен нажатию
кнопки Отмена.

Если список дел показывает список отфильтрованный по какому-либо критерию,
то это отражается на панели просмотра.

Различные фильтры, применённые к текущему виду, отображаются отдельными
элементами на панели просмотра. Каждый из этих элементов можно отключить,
кликнув на него, и нажав Удалить. 

Любой набор фильтров можно сохранить как шаблон и затем возвращаться к
нему при необходимости через меню шаблонов в правой части.

Данное меню позволяет легко переключаться между сохраненными шаблонами.

Настроить список шаблонов в меню можно нажав на пункт Выбор шаблонов в
меню шаблонов.

Поле поиска позволяет использовать операторы AMD / OR (и/или) для
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более сложных запросов. Операторы должны быть написаны заглавными
английскими буквами.

Следует иметь в виду, что все рассмотренные приёмы сортировки и
фильтрации могут быть использованы одновременно, дополняя друг
друга.

Учет времени

При анализе проектов зачастую очень важно знать сколько времени было
затрачено на те или иные действия. EssentialPIM Pro автоматически
подсчитывает необходимое/затраченное время для текущего списка дел и
показывает результат в строке состояния. Чтобы посчитать время для
определенных дел, их необходимо выделить.

В результате, на ряду со временем для всего списка, программа подсчитает и
отобразит время для выделенных дел. Подсчет ведётся исходя из даты начала
дела и даты завершения (т.е. когда дело было помечено как 100%
завершенное). В случае, если дело не помечено как завершенное, вместо даты
завершения берется дата планируемого окончания дела.

Если строка состояния не отображается, значит ее надо включить
через меню Вид -> Строка состояния.

4.6 Заметки

4.6.1 Работа с заметками

Модуль Заметки представляет собой удобный инструмент для хранения и
ведения ежедневных записей. Инструментарий модуля предлагает не только
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стандартный набор функций текстового редактора, но и позволяет организовать
заметки в иерархическую структуру, разделять на отдельные списки и даже
прикреплять отдельные заметки на рабочий стол в виде записок. Эти и ряд
других функций, делают модуль Заметки мощным дополнением для управления
ежедневным потоком информации.

Добавление заметки

Добавить заметку можно несколькими способами. Самый простой способ - это
нажать кнопку Добавить в корень на панели инструментов, это добавит
заметку в корень активного в данный момент дерева заметок.

Чтобы создать Дочернюю, либо  Одноуровневую заметку, нажмите на кнопку
со стрелкой рядом с кнопкой Добавить в корень и выберите соответствующий
пункт. 

В первом случае будет создана дочерняя заметка по отношению к выделенной, а
во втором - заметка будет добавлена на тот же уровень, что и выделенная в
данный момент. Новую заметку можно также создать через меню Действия ->
Новая заметка.

При использовании любого из перечисленных способов откроется диалог, в
котором можно указать основные параметры заметки:
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Имя - название создаваемой заметки. Если в это поле ничего не ввести то в
качестве имени будет взято первое предложение заметки.
Выбрать иконку - позволяет присвоить заметке иконку. Диалог выбора иконок
позволяет добавлять иконки из внешних файлов.
Статус - позволяет установить статус списка - личный, либо публичный.
Стикер - добавляет заметку на рабочий стол в виде липкого листочка. Более
подробно об этом можно прочитать в теме Стикер.

После введения всех необходимых параметров, можно нажать кнопку ОК, в
результате чего будет создана заметка размещенная в списке активного в
данный момент дерева заметок.

Ctrl+R - горячее сочетание для добавления новой заметки
Shift+Ctrl+N - глобальное сочетание для добавления новой заметки
(работает даже когда окно программы не активно в данный момент)
Заметку также можно добавить через меню Файл -> Новый ->
Заметка

Списки заметок

Для удобства разделения заметок различной тематики, EssentialPIM Pro
предлагает использовать отдельные списки или деревья. Переключение между
деревьями осуществляется при помощи закладок в нижней части области со
списком заметок. По умолчанию создается основной список под названием 
Дерево 1.  Чтобы добавить новое дерево, либо изменить уже имеющееся, надо
вызвать контекстное меню дерева, щелкнув правой кнопкой мыши по его
названию.

Переименовать - позволяет переименовывать текущее дерево заметок.
Добавить - создает новое дерево.
Удалить - удаляет текущее дерево со всеми заметками, содержащимися в нем.
Цвет - позволяет изменить фон закладки с названием дерева.
Статус - позволяет установить статус списка - личный, либо публичный.

Списки заметок можно перемещать между собой путем перетаскивания,
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удерживая левую кнопку мыши.

Новое дерево заметок можно также создать через меню Действия ->
Новое дерево

Управление структурой заметок

Для удобства и наглядности хранимой информации, EssentialPIM Pro помимо
списков поддерживает организацию заметок в древовидную структуру.
Структура уже созданного дерева заметок может быть с легкостью
отредактирована. Самый простой способ - это перетащить заметку, удерживая
левую кнопку мыши, на требуемую позицию. Во время перетаскивания курсор
будет подсвечивать на какую позицию попадёт заметка. Чтобы сделать заметку
дочерней, нужно перетащить её на название будущей родительской заметки,
как только родительская заметка станет подсвеченной, можно отпустить левую
кнопку мыши.

Перемещать дела можно также используя соответствующие кнопки на панели
инструментов.

Кнопки со стрелками перемещают выделенную заметку в соответствующем
направлении.

Чтобы быстро свернуть, либо развернуть все ветки заметок, можно
воспользоваться соответствующими кнопками на панели инструментов - 
Свернуть/Развернуть все.

Если перемещаемая заметка имеет дочерние заметки, то она будет
перемещена вместе со всей структурой подчинённых заметок.

Отдельные заметки и целые структуры заметок можно перемещать
между списками. Для этого надо выделить необходимую заметку и
перетащить на название требуемого списка, при этом новый список
станет активным, после чего, продолжая удерживать левую кнопку
мыши, поместить заметку на необходимую позицию. Переместись
заметки между списками можно также воспользовавшись стандартными
функциями Вырезать/Вставить.
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Ins - вставка дочерней заметки относительно текущей выделенной
Ctrl+G - вставка новой заметки на тот же уровень.

Перемещение по списку заметок

Модуль заметок содержит панель навигации.

Данная панель показывает путь к выделенной в данный момент заметке. Клик на
имя заметки в пути переключает фокус на соответствующую заметку. Кнопки о
стрелками позволяют перемещаться между последними открытыми заметками.

Создание событий из заметки

EssentialPIM позволяет создавать событие в календаре, либо дела напрямую из
текста заметки. Чтобы создать такое событие нужно выделить необходимый
текст в теле заметки, вызвать контекстное меню и воспользоваться командой 
Создать -> Задача/Дело.

При этом будет открыто окно редактирования задачи/дела, в поле заметок
которого уже будет вставлен выделенный фрагмент текста. При этом для
создания события будет использован текущий шаблон по умолчанию. При
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создании дела, оно будет добавлено в корень листа, активного в данный момент.

4.6.2 Редактирование заметок

EssentialPIM Pro предлагает стандартный набор инструментов для
редактирования текста, вставки изображений и таблиц.

Каждая заметка может содержать несколько листов. Листы отображаются в
нижней части окна в виде закладок. По умолчанию в новой заметке создается
лист под названием Лист 1. Переименовать или добавить новые листы можно
через контекстное меню.

имг

Переименовать - позволяет переименовывать текущий лист.
Добавить - создает новый лист.
Удалить - удаляет текущий лист.
Копировать как ссылку - копирует ссылку на вкладку в буфер обмена. Затем
ее можно вставить в другие записи, возможно даже использование ссылки в
других программах.
Отправить по E-mail - создает электронное сообщение с содержимым вкладки
в теле письма. Сообщение создается при помощи почтового клиента
установленного в системе по умолчанию.
Цвет - позволяет изменить фон закладки с названием листа.
Копировать как ссылку - более подробно использование данной функции
описано тут.
Статус - позволяет установить статус листа - личный, либо публичный.
Только чтение - переводит лист в режим только для чтения, что защищает
содержимое листа от случайного редактирования.

Листы в заметке можно перемещать между собой путем перетаскивания,
удерживая левую кнопку мыши.
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Помимо листов, каждая заметка может содержать вложенные файлы, за это
отвечает вкладка Вложения.  Чтобы добавить вложение, нажмите кнопку со
символом скрепки на панели инструментов.

Принципы работы с вложениями одинаковы во всех модулях программы и более
подробно рассмотрены в теме Вложения.

4.6.3 Липкие листочки

Зачастую в процессе работы может возникнуть необходимость иметь какие-то
данные перед глазами в качестве напоминания, либо просто для информации.
Для таких целей EssentialPIM Pro предлагает функцию Стикер (или липкие
листочки), при помощи которой любую заметку можно прикрепить прямо на
рабочий стол в виде записки.

Стикер полностью связан с родительской заметкой и все изменения сделанные в
нём, появятся и в родительской заметке, равно как и наоборот - изменения в
окне программы будут отражены в записке на рабочем столе.

Преобразовать заметку в стикер можно несколькими способами. Самый простой
- это нажать кнопку Стикер на панели инструментов либо включить параметр
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Стикер в контекстном меню заметки.

Заметку в виде стикера можно также сделать прямо при создании заметки,
включив соответствующий параметр. Еще один способ создания стикера из
заметки, через меню Действия -> Стикер.

Работа со стикером

Сам стикер представляет собой мини текстовый редактор, в котором можно
вносить простые изменения в тексте. Записка может быть перемещена в любую
часть рабочего стола и будет закрываться/открываться вместе с самой
программой (EssentialPIM). В верхней части стикера имеется небольшая панель
инструментов, позволяющая управлять запиской.

Кнопки панели выполняют следующие функции (слева направо):

Кнопка настроек - позволяет установить прозрачность и цвет фона записки.
Поверх всех окон - закрепляет стикер поверх всех окон
Свернуть/развернуть - сворачивает стикер, либо разворачивает до полного
размера.
Спрятать - снимает параметр стикер с заметки, при этом стикер убирается с
рабочего стола, но родительская заметка остается в EssentialPIM.
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Настройки стикера

Настройки стикера можно изменить через меню Сервис -> Настройки ->
Заметки -> Стикеры.

Данный диалог позволяет установить размер и цвет которые будут
использоваться по умолчанию для новых записок.

4.7 Контакты

4.7.1 Работа с контактами

Модуль Контакты является мощным инструментом для хранения и управления
контактами. EssentialPIM Pro предоставляет в распоряжение пользователя
инструменты по группировке и редактированию записей, созданию почтовых
рассылок по различным группам контактов, созданию и печати конвертов и
наклеек/этикеток.

Добавление контакта

Добавить контакт можно несколькими способами. Самый быстрый это нажать
кнопку Добавить контакт на панели инструментов. Либо через меню Действия
-> Новый контакт.

Контакт также можно создать двойным щелчком мыши по пустой части рабочей
области экрана. При использовании обоих способов открывается окно
редактирования контакта, в котором можно указать имя, фамилию, адрес,
телефон прочие данные. Более подробно параметры контакта рассмотрены в
теме Редактирование контакта.

Ins - горячая клавиша для добавления нового контакта
Shift+Ctrl+C - глобальное сочетание клавиш для добавления нового
контакта (работает даже когда окно программы не активно в данный
момент)
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Контакт также можно добавить через меню Файл -> Новый -> Контакт

Создание групп

Любой человек так или иначе взаимодействует с людьми из разных сфер жизни.
Это могут быть родственники, знакомые или бизнес партнеры. Соответственно,
эффективное упорядочивание контактов является жизненной необходимостью в
организации информации. EssentialPIM Pro предлагает решить данную задачу при
помощи групп контактов.

Список групп находится слева от списка контактов и представляет собой
древовидную структуру папок. Чтобы создать группу, нужно нажать кнопку со
стрелкой вниз рядом с кнопкой Добавить Контакт и выбрать Добавить группу
на панели инструментов либо через меню Действия -> Новая группа.

После этого будет открыто диалоговое окно, в котором можно ввести название
группы, дать поясняющие заметки, указать участников группы и заполнить
множество других данных. Более подробно параметры групп рассмотрены в теме 
Редактирование группы.

Группы контактов могут быть упорядочены в древовидную структуру.
Инструменты для этой функции не вынесены на панель действий. Тем ни менее,
группы можно перемещать между собой и делать их дочерними для  других
групп. Чтобы отредактировать структуру групп, нужно перетащить требуемую
группу, удерживая левую кнопку мыши, на нужную позицию. Во время
перетаскивания курсор будет подсвечивать куда попадет группа. Чтобы сделать
группу дочерней нужно перетащить ее на название будущей родительской
группы, как только родительская группа станет подсвеченной, можно отпустить
левую кнопку мыши.

Ctrl+G - горячее сочетание для добавления группы.

Управление контактами

Чтобы поместить контакт в ту или иную группу, можно просто перетащить его на
нужную группу удерживая левую кнопку мыши. Контакт может быть в
нескольких группах, для этого его можно перетащить тем же способом в разные
группы. Чтобы убрать контакт из группы, либо отредактировать набор групп, в
которых находится контакт, можно воспользоваться полем Член группы в
диалоге информации о контакте.
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В этом поле, через запятую, перечислены группы, членом которых является
данный контакт. Список можно отредактировать вручную, либо, чтобы избежать
опечаток, нажать кнопку с тремя точками в конце строки. Это вызовет
диалоговое окно, в котором можно отредактировать членство контакта.

Галочками следует отметить принадлежность контакта к группам.

Стоит заметить, что при размещении контакта в разных группах, сам
контакт не копируется и остается в базе в единственном экземпляре.
Объясняется это тем, что группы, хоть и похожи на папки, работают
несколько иначе нежели папки в Windows. Группы контактов в
EssentialPIM Pro больше походят на ярлыки, нежели на папки с файлами
в их классическом понимании.

Настройка основного вида

EssentalPIM Pro позволяет настроить набор отображаемых столбцов в рабочей
области модуля Контакты.

Кликните правой кнопкой мыши по заголовку таблицы, чтобы вызвать меню в
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котором можно включить/отключить столбцы.

Выбрав пункт Настроить, в появившемся окне можно настроить набор
отображаемых колонок из всех доступных.

Если необходимо изменить порядок столбцов в основном виде контактов, то
порядок можно изменить путем перетаскивания заголовков столбцов левой
кнопкой мыши на нужные позиции. Во время перетаскивания значок стрелочки
показывает куда будет помещен столбец после того, как левая кнопка мыши
будет отпущена.

EssentialPIM Pro запоминает положение столбцов для каждой группы контактов.
Если необходимо скопировать порядок столбцов текущей группы в другие, то
для этого надо вызвать контекстное меню (правый клик мыши) заголовка
таблицы контактов, затем воспользоваться пунктом Применить настройки и
выбрать группу к которой требуется применить тот же набор и порядок
столбцов.

Сортировка, поиск контактов

EssentialPIM Pro предлагает ряд инструментов для удобной и быстрой навигации
по спискам контактов, которые позволяют найти необходимую запись в
несколько кликов. 
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Первое, чем можно воспользоваться - это строка поиска в правом верхнем углу
окна.

Нажав на значок лупы, можно указать поле по которому следует провести
поиск. Для проведения более сложного поиска по нескольким критериям, можно
воспользоваться функцией расширенного поиска.

Следующее чем можно воспользоваться - это сортировка контактов по
столбцам. Для этого надо щелкнуть левой кнопкой мыши по заголовку столбца
по которому требуется провести сортировку. В результате чего контакты будут
отсортированы по возрастанию, при этом у заголовка столбца появится значок
стрелочки, которая показывает порядок сортировки. Второй щелчок меняет
порядок сортировки на противоположный. Для сортировки по нескольким
столбцам, необходимо при клике на названия столбцов удерживать клавишу
Ctrl.

Для быстрой навигации по списку контактов можно воспользоваться
алфавитным указателем в правой части рабочей области модуля Контакты.
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При нажатии на букву указателя, EssentialPIM переместит курсор на первый
контакт начинающийся с этой буквы. В качестве ключевого поля принимается
то, по которому контакты отсортированы на текущий момент. Алфавитный
указатель может содержать несколько языков. Чтобы настроить отображаемые
алфавиты, нужно нажать на кнопку в нижней части панели и выбрать
необходимые языки.

Для фильтрации контактов сразу по нескольким столбцам и критериям,
EssentialPIM Pro предлагает воспользоваться режимом фильтра. Чтобы перейти в
этот режим, нажмите кнопку Фильтр на панели инструментов, в результате чего
у заголовка каждого столбца появится выпадающее меню фильтра.
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Данное окно содержит все значения, встречающиеся в текущем столбце.
Галочками можно отметить значения, которые требуется отобразить в списке.
Если значений очень много, то можно воспользоваться строкой поиска в верхней
части окна. Как только все значения отмечены, можно нажать кнопку ОК для
применения фильтра. Щелчок мыши за пределами окна равносилен нажатию
кнопки Отмена.

Применение фильтров отражается на панели просмотра.

Различные фильтры, примененные к текущему виду, отображаются отдельными
элементами на панели просмотра. Каждый из этих элементов можно отключить,
кликнув на него, и нажав Удалить. 

Любой набор фильтров можно сохранить как шаблон и затем возвращаться к
нему при необходимости через меню шаблонов в правой части.

Данное меню позволяет легко переключаться между сохраненными шаблонами.
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Настроить список шаблонов в меню можно нажав на пункт Выбор шаблонов в
меню шаблонов.

Поле поиска позволяет использовать операторы AMD / OR (и/или) для
более сложных запросов. Операторы должны быть написаны заглавными
английскими буквами.

Алфавитный указатель может быть включен, либо отключен через
меню Вид -> Индекс.

Следует иметь в виду, что все рассмотренные приемы сортировки и
поиска могут быть использованы одновременно, дополняя друг друга.

Настройки модуля Контакты

EssentialPIM Pro позволяет внести ряд корректировок во внешний вид модуля 
Контакты. Настройки можно изменить через меню Сервис -> Настройки ->
Контакты.
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Добавлять адресатов Почты в Собранные Адреса - данная функция
включает/отключает сбор адресатов которые проходят через модуль почты в
группу Собранные адреса в модуле контактов. Скрыть фото контакта в
предпросмотре - включает/отключает отображение фотографии контакта в
предпросмотре в главном виде модуля Контакты.

Преобразование контактов в другие типы записей

Любой контакт можно преобразовать в событие или дело. Для этого надо
вызвать контекстное меню контакта при помощи правой кнопки мыши и выбрать
необходимый тип преобразования в подменю Преобразовать в...

При этом откроется диалог редактирования события/дела, в котором имя
контакта уже будет вставлено в поле тема в виде ссылки.

4.7.2 Редактирование контакта

Редактирование контакта может быть осуществлено несколькими способами.
Список контактов представлен в виде таблицы, поэтому самый простой способ
внесения изменений в уже созданные контакты - это редактирование их прямо в
рабочей области модуля, редактируя ячейки таблицы. Поля, отображаемые в
таблице, легко могут быть настроены под нужды пользователя. Для этого нужно
правым щелчком мыши по заголовку таблицы вызвать контекстное меню и
выбрать необходимые поля.

Порядок полей может быть изменен, для этого надо перетащить заголовки
таблицы на нужные позиции удерживая левую кнопку мыши.
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EssentialPIM Pro запоминает порядок и расположение полей отдельно
для каждой из групп контактов.

Режимы отображения контактов

Чтобы получить доступ ко всем полям контакта, следует открыть окно
редактирования контакта двойным щелчком левой  кнопки мыши, либо нажав
кнопку Изменить на панели инструментов.

Есть два режима отображения данных  контакте. Один группирует поля контакта
по тематическим разделам, он находится во вкладке Контакт. Второй
представляет список полей в более компактной общей таблице и находится во
вкладке Все поля. Ниже представлен обзор обоих режимов.

Вкладка Контакт (по умолчанию):

Данный диалог позволяет изменить любые данные о контакте. Для удобства
пользователя элементы управления и данные разделены на отдельные области:
1. Панель форматирования текста.
2. Инструменты управления полями, позволяющие создавать новые и
редактировать формат имеющихся полей.
3. Инструменты управления доступа к контакту. Позволяют сделать контакт
доступным только для чтения и изменить его статус. Данные параметры влияют
на различные аспекты доступа, отображения, синхронизации и защиты данных.



EssentialPIM Pro файл помощи70

© 2019 Astonsoft Ltd.

Поле Статус также используется в EssentialPIM Pro Бизнес для назначения
записей другим пользователям. Более подробно о назначении записей и статусах
можно прочитать здесь.
4. Основные данные о контакте, такие как имя, фамилия, фото и различные
контактные данные.
5. Дополнительные данные. Этот раздел может включать дополнительные поля
различных форматов. Пользовательские поля добавляются в этот раздел.
6. Поле Член группы показывает в каких группах находится данный контакт.
Более подробно можно прочитать здесь.
7. Область заметок представляет собой простой текстовый редактор с базовыми
инструментами форматирования текста.
8. Здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.

Вкладка Все поля:

1. Инструменты управления полями, позволяющие создавать новые и
редактировать формат имеющихся полей.
2. Инструменты управления доступа к контакту. Позволяют сделать контакт
доступным только для чтения и изменить его статус. Данные параметры влияют
на различные аспекты доступа, отображения, синхронизации и защиты данных.
Поле Статус также используется в EssentialPIM Pro Бизнес для назначения
записей другим пользователям. Более подробно о назначении записей и статусах
можно прочитать здесь.
3. Область со всеми данными о контакте. Здесь содержатся как стандартные
поля, такие как имя, фамилия, телефон, адрес и пр., так и пользовательские
поля, а также поле Член группы.
4. Область заметок представляет собой простой текстовый редактор с базовыми
инструментами форматирования текста.
5. Здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.
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Доступ ко всем полям можно также получить и в рабочей области модуля
контактов, не открывая диалога редактирования. Для этого можно
воспользоваться панелью предпросмотра в нижней части рабочей обрасти
модуля.

Контакт - в этой вкладке собраны все заполненные поля контакта.

Связанные записи - в этой вкладке собираются все записи в которых есть
ссылка на данный контакт. Также здесь можно найти все электронные письма
связанные электронными адресами указанными в данных контакта.

Настройка полей

Практически все поля в модуле Контакты являются редактируемыми. Для того
чтобы изменить названия и свойства полей, необходимо открыть диалог
редактирования любого контакта и воспользоваться кнопками редактирования
полей в верхней части окна либо. Для быстрого добавления поля можно
воспользоваться кнопкой Добавить в любом из разделов.
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Добавить поле - создает новое поле. При создании поля можно указать его имя
и тип данных, после чего поле будет автоматически помещено в
соответствующий раздел.
Изменить поле - позволяет изменить названия и формат любого поля.
Добавить - добавляет поле в раздел.

Поля в модуле Контакты могут содержать разные типы данных, такие как:
текст, дата и время, выпадающее меню и ряд других. Поэтому, при добавлении
нового поля, вы видите диалог, в котором можно установить эти параметры.

Текст - обычное поле для ввода текстовых данных в одну строку, не имеет
дополнительных настроек.
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Телефон - данный формат определяет содержимое поля как телефонный номер.
При наличии модема данное поле позволяет набирать телефонный номер
напрямую из программы. При синхронизации с мобильными устройствами и
интернет сервисами это поле также переносится как телефонный номер.

Адрес - данное поле содержит дополнительные подчиненные поля для хранения
строк адреса.

Дата - поле, в которое можно ввести дату воспользовавшись календарем. Поле
с форматом Дата может быть использовано для автоматического создания
ежегодного события в календаре (дни рождения, праздники, годовщины). 

Показывать как задачу в категории - включает/отключает автоматическое
создание ежегодного события в календаре. Выпадающее меню позволяет
выбрать категорию для создаваемой серии задач.
Показывать внизу на экране Календаря - включает/отключает строку с
уведомлением о предстоящем ежегодном событии в нижней части рабочей
области Календаря. По умолчанию уведомление появляется за 3 дня до
наступления события.

Список выбора - создает поле в виде выпадающего меню.

Кнопки Добавить и Удалить позволяют создать список значений выпадающего
меню, а кнопки Вверх и Вниз отредактировать порядок значений в списке.

Да/Нет - также создает поле в виде выпадающего списка, но, в отличии от
списка выбора, имеет бинарный формат и может иметь только два значения.
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Выпадающее меню Формат позволяет выбрать какая именно пара значений
будет использоваться. Нажав кнопку с тремя точками возле выпадающего меню,
можно добавить свою пару значений.

Флажок - создает чекбокс, который может быть либо включен, либо выключен.
Данное поле не имеет дополнительных настроек.

Следует иметь в виду, что все изменения в структуре полей
применяются ко всем контактам в базе, не зависимо от того в каком
контакте или группе было сделано изменение.

Поля Имя, Фамилия, Член группы и Место работы не могут быть
удалены, так как являются ключевыми и используются в
синхронизациях. Поле Член группы также не является редактируемым. 

4.7.3 Редактирование группы

Группа, также как и контакты, может иметь ряд значений. Поля группы
контактов не отображается в интерфейсе программы явно, как это обстоит с
контактами. Получить доступ к параметрам группы можно по двойному щелчку
левой кнопки мыши по имени группы.

Вкладка Свойства группы.
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1. Инструменты управления полями, позволяющие создавать новые и
редактировать формат имеющихся полей. Приёмы редактирования полей группы
идентичны таковым в контактах. 
2. Инструменты управления доступа к группе. Позволяют сделать группу
доступной только для чтения и изменить ее статус. Данные параметры влияют
на различные аспекты доступа, отображения, синхронизации и защиты данных.
Поле статуса также используется в EssentialPIM Pro Бизнес для назначения
записей другим пользователям. Более подробно о назначении записей и статусах
можно прочитать здесь.
3. Область с данными о группе содержит основные и пользовательские поля.
4. Область заметок представляет собой простой текстовый редактор с базовыми
инструментами форматирования текста.
5. Здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.

Вкладка Члены группы позволяет управлять списком членов группы.
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1. Панель управления членами группы. При помощи этих кнопок можно добавить
контакты в группу из имеющегося списка контактов, удалить из списка, а также
создавать новые контакты.
2. Список членов группы. Двойной щелчок левой кнопкой мыши открывает
диалог с информацией о контакте.
3. Здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.

4.8 Почта

4.8.1 Создание почтового ящика

EssentialPIM Pro включает в себя полноценный почтовый клиент, с классическим
набором инструментов, с поддержкой как IMAP так и POP3 протоколов, почтовых
фильтров, не ограниченного количества учетных записей, PGP шифрования и
прочих функций. Интеграция с модулем Контакты делает отправку писем и
почтовых рассылок группам пользователей простой и удобной.

Добавление учетной записи

Прежде чем начать работу с почтой, необходимо создать новую учетную запись.
Сделать это можно через меню Файл -> Новый -> Почтовый ящик, либо,
находясь в модуле Почта через меню Сервис -> Почтовые ящики ->
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Добавить. В обоих случаях это вызывает мастер создания учетной записи
почты.

На первом шаге предлагается заполнить поля Имя и Адрес e-mail - значения
именно этих полей получатель будет видеть в поле "От кого" при получении
писем. 

На втором и третьем шаге необходимо ввести параметры серверов входящей и
исходящей почты, соответственно. Для входящей почты доступно два типа
серверов IMAP4 и POP3. Для большинства известных почтовых сервисов,
параметры серверов заполнятся автоматически. Однако, если вы не уверены в
правильности заполнения параметров, обратитесь в раздел помощи вашего
почтового провайдера. Как правило, список параметров для почтовых серверов
находится в разделе часто задаваемых вопросов (ЧАВО или FAQ).

http://ru.wikipedia.org/wiki/IMAP
http://ru.wikipedia.org/wiki/POP3
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На последнем шаге предлагается создать PGP ключи для почтового ящика.
Подробнее о PGP шифровании тут (вы можете пропустить этот шаг). А также, в
случае использования POP3 почтового аккаунта, создать глобальные папки (рис.
слева). Эта функция может быть полезной когда используется большое
количество ящиков, при этом используется один набор папок для всех учетных
записей. Для учетных записей использующих IMAP, функция глобальных папок
не доступна (рис. справа).

Тип сервера входящей почты указывается на этапе создания почтового
ящика. Изменить тип сервера для уже созданных ящиков нельзя.

Параметр Использовать Глобальные папки можно присвоить только при
создании почтового ящика. Нельзя отключить, либо включить данный
параметр для уже созданного ящика.

Настройки учетной записи почты всегда можно откорректировать через
меню Сервис -> Почтовые ящики ->  Изменить.

4.8.2 Работа с почтой

Как только были созданы почтовые учётные записи, можно приступать к работе
с почтой.

Получение почты

Самым простым и быстрым способом получения почты, является запуск проверки
всех почтовых ящиков (если их несколько). Чтобы проверить все почтовые
ящики, достаточно нажать кнопку Получить/Отправить на панели действий
слева. Если  требуется проверить почту только в одном конкретном ящике, то
это можно сделать через меню Сервис -> Получить. В обоих случаях будет
вызвано диалоговое окно статуса отправки и получения почты.
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Данный диалог показывает состояние процесса отправки/получения почты. Если
в процессе возникнут какие-либо неполадки, то именно в этом окне в столбце
статус будет показано сообщение об ошибке. Наиболее часто встречающиеся
ошибки рассмотрены тут. 

Данный диалог также позволяет остановить процесс проверки почты как для
одного ящика (для этого надо выделить необходимую учетную запись и нажать 
Прервать), так и для всех учетных записей сразу, нажав кнопку Прекратить
все.

Ctrl+Alt+A - получить и отправить всю почту.
Ctrl+Alt+R - получить всю почту.

Создание и отправка писем 

При помощи EssentialPIM вы можете:

- Создать новое письмо. Для создания нового письма нужно нажать кнопку
Новое письмо на панели действий, либо через меню Действия -> Новое
письмо. 
- Ответить на полученное сообщение. Чтобы ответить на полученное письмо,
необходимо выделить сообщение  и нажать кнопку Ответить, либо Ответить
всем. При этом текст исходного сообщения будет помещен в тело письма в
качестве цитаты, а в поле получателя будет автоматически поставлен адрес
отправителя исходного письма. В случае ответа всем, копия письма будет
отправлена всем получателям исходного письма, их адреса будут прописаны в
поле Копия. Данная функция может быть полезной, когда переписка ведется
между группой лиц и требуется чтобы все участники переписки были в курсе
всех сообщений.
- Переслать сообщение. Чтобы переслать полученное сообщение другому
адресату, нужно выделить необходимое письмо и нажать на кнопку Переслать.
При этом исходное сообщение будет вставлено в тело письма без каких либо
изменений текста и форматирования, останется только добавить новый адрес
получателя.
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В результате всех перечисленных случаев, будет открыто окно создания/ответа
на письмо.

Данное окно предоставляет собой стандартный набор инструментов для
создания и редактирования писем. Поддерживается как расширенный (HTML),
так и простой текстовый формат для текста внутри сообщения. Переключение
между форматами осуществляется через меню Формат.

Поле От Кого содержит список персоналий от всех установленных почтовых
ящиков. При изменении отправителя автоматически меняется подпись
ассоциированная с данным отправителем.
Нажав на кнопки Кому, Копия или Скрытая можно добавить адреса
получателей в соответствующие поля с помощью дополнительного окна.



Работа с EssentialPIM Pro 81

© 2019 Astonsoft Ltd.

Список слева показывает доступные контакты с адресами в базе, справа -
получатели в соответствующих полях. Чтобы добавить или удалить адресатов из
списков, нужно выделить контакт(ы) и нажать соответствующую кнопку со
стрелкой. Чтобы облегчить поиск необходимых контактов, можно
воспользоваться выпадающим меню Адресная книга и полем Поиск. Меню
Адресная книга позволяет показать контакты только из определенных групп.

Окно редактирования письма также содержит вкладку Вложения, которая
позволяет прикреплять файлы к письму. Принцип работы с вложениями в почте
такой же как и во всех остальных модулях программы. Более подробную
информацию о работе с вложениями можно найти тут.

Как только письмо готово, его можно немедленно отправить, нажав кнопку
Отправить. Если работа над сообщением не закончена, его можно сохранить в
папку Черновики и продолжить работу над ним позже. Это можно сделать через
меню Файл -> Сохранить, либо просто закрыть окно редактирования письма и
подтвердить запрос на сохранение в черновики.

Десять последних значений поля Тема в письмах сохраняются в базе данных для
последующего использования. Ранее использованные темы можно выбрать из
выпадающего меню.
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Список сохраненных тем можно редактировать, для этого в выпадающем списке
надо выбрать пункт Управление темами. Это откроет диалоговое окно, где
можно редактировать список. В этом же окне можно "прикреплять" темы путём
выставления галочки в колонке Pinned, чтобы они всегда были в списке и не
уходили из него со временем, после появления новых тем.

Опция Не сохранять темы автоматически, отключает автоматическое
добавление новых пунктов в список.

Шаблоны и заготовленные ответы

Любое письмо может быль сохранено как шаблон через меню Файл ->
Сохранить как -> Шаблон. Шаблоны сохраняются в специальную папку
Шаблоны (Templates). Открыв такое письмо, на его основе можно создать
новое сообщение.

EssentialPIM Pro позволяет сохранять часто используемые фразы и легко
вставлять их в процессе редактирования письма. В режиме редактирования
письма перейдите в меню Вставка -> Заготовленные ответы -> Управление.
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Данное окно позволяет сохранять и редактировать имеющиеся заготовки.
Верхняя часть окна содержит список уже имеющихся заготовок, а нижняя -
содержимое выделенной заготовки, здесь же можно ее редактировать как в
привычном текстовом редакторе. Все заготовленные ответы из этого меню
представлены списком в том же порядке в меню Вставка -> Заготовленные
ответы.

К письму можно добавить запрос на подтверждение о получении, это
можно сделать через меню Настройки -> Подтверждение получения.

Ctrl+M - отправить письмо
Ctrl+S - сохранить письмо в черновик

Настройки почты

Общие настройки почты доступны через меню Сервис -> Настройки -> Почта.
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Отправлять письма немедленно - если функция включена, то при нажатии
кнопки Отправить, в окне создания письма, письмо помещается в папку
Исходящие и отправляется немедленно. Если опция отключена, то письмо
помещается в папку Исходящие и ждет ручной отправки.
Отсылать неотправленные при выходе - отправляет все письма из папки
Исходящие при выходе из программы. Данная функция может быть полезна если
параметр Отправлять письма немедленно отключен.
Проверять при запуске, что EssentialPIM является почтовой программой
по умолчанию - данная функция должна быть всегда включена, если требуется
чтобы EssentialPIM всегда оставался почтовым клиентом по умолчанию.
Проверка отсутствия вложений - в момент отправки письма напоминает о
том, что вы забыли добавить вложенный файл, если в тексте встречаются
определенные ключевые слова. Список ключевых слов можно настроить нажав
на кнопку Ключевые слова.

Портативная версия EssentialPIM не может быть установлена клиентом
по умолчанию.

 Если ваше интернет подключение использует прокси сервер, то его
параметры можно настроить тут.
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4.8.3 Виды просмотра, сортировка, фильтрация

Виды просмотра почты

Модуль почты может отображаться в трех видах: классическом
(горизонтальном), вертикальном и широком (вариация классического вида).

Установить данный параметр можно в меню Вид -> Вид.

В любом из видов список писем может быть сгруппирован по перепискам с
отдельными корреспондентами. Чтобы включить этот режим нажмите кнопку 
Переписка на панели модулей, либо в меню Вид.

Изображения в предпросмотре

В целях безопасности окно предпросмотра не загружает рисунки из Интернета
по умолчанию.
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Чтобы загрузить рисунки, кликните желтую линию вверху письма и выбирите
необходимый вариант загрузки.

Действия с адресами От Кого/Кому

При клике на любой адрес в заголовочной части письма открывается меню, с
помощью которого можно добавить адрес в список контактов, отредактировать,
скопировать или создать правило.

Настройка основного вида

EssentalPIM Pro позволяет настроить набор отображаемых столбцов в рабочей
области модуля Почта.

Кликните правой кнопкой мыши по заголовку таблицы, чтобы вызвать меню в
котором можно включить/отключить столбцы.

Если требуется изменить порядок колонок, то их можно перетащить на нужные
позиции удерживая левой кнопкой мыши. Иконка со стрелочкой показывает куда
будет помещена перетаскиваемая колонка.
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EssentalPIM Pro запоминает настройки колонок для каждой папки в почте. Для
быстрого копирования настроек в другие папки можно воспользоваться пунктом
меню Применить к....

Сортировка и фильтрация

Самый простой способ - это сортировка писем по колонкам. Для этого надо
щелкнуть левой кнопкой мыши по заголовку столбца по которому требуется
провести сортировку. В результате чего письма будут отсортированы по
возрастанию, при этом у заголовка столбца появится значок стрелочки, которая
показывает порядок сортировки. Второй щелчок меняет порядок сортировки на
противоположный. Для сортировки по нескольким столбцам при щелчке на
названия столбцов следует удерживать клавишу Ctrl.

Для поиска либо фильтрации писем по одному ключевому слову, можно
воспользоваться строкой поиска в правом верхнем углу окна.

Нажав на значок лупы, можно указать поле, по которому следует провести
поиск.

Для фильтрации писем сразу по нескольким столбцам и критериям, EssentialPIM
Pro предлагает воспользоваться режимом фильтра. Чтобы перейти в этот режим,
нажмите кнопку Фильтр на панели инструментов, в результате чего у заголовка
каждого столбца появится выпадающее окошко фильтра.
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Данное окно содержит все значения, встречающиеся в текущем столбце.
Галочками можно отметить значения, которые требуется отобразить в списке.
Если значений очень много, то можно воспользоваться строкой поиска в верхней
части окна. Как только все значения отмечены, можно нажать кнопку ОК для
применения фильтра. Щелчок мыши за пределами окна равносилен нажатию
кнопки Отмена.

В почте также имеется панель быстрого фильтра:

C помощью него можно быстро отобразить только непрочитанные письма,
помеченные звездой, письма с вложениями, либо письма от корреспондентов из
вашего списка контактов.

Если применен какой-либо фильтр, то в верхней части окна появится панель 
Индивидуального вида, которая показывает какие типы фильтров применены в
данный момент. Чтобы удалить какой-либо из фильтров, надо кликнуть по нему
курсором и выбрать команду Показать.

Поле поиска позволяет использовать операторы AMD / OR (и/или) для
более сложных запросов. Операторы должны быть написаны заглавными
английскими буквами.

Следует иметь в виду, что все рассмотренные приемы сортировки и
фильтрации могут быть использованы одновременно, дополняя друг
друга.
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4.8.4 Настройка почтовых ящиков

Параметры установленных почтовых ящиков могут быть изменены через меню 
Сервис -> Почтовые ящики.

Данный диалог представляет список установленных почтовых ящиков и
предлагает ряд настроек:

Добавить - создает новый почтовый ящик при помощи мастера создания новой
учетной записи. 
Изменить - открывает диалог настройки почтового ящика, ниже он рассмотрен
более подробно.
Удалить - удаляет почтовый ящик вместе со всеми письмами. 
По умолчанию - позволяет присвоить это свойство одному из почтовых
ящиков. Именно этот ящик будет использоваться при создании новых писем не
из модуля почты. Например, при создании письма из модуля Сегодня или при
клике на адрес электронной почты в EssentialPIM, браузере и ряде других
программ. 
Вверх/Вниз - меняет порядок отображения ящиков в главном окне модуля.

Итак, нажав кнопку Изменить, будет вызван диалог настройки почтового ящика,
состоящего из четырех вкладок.



EssentialPIM Pro файл помощи90

© 2019 Astonsoft Ltd.

Вкладка Общие содержит данные об учетной записи и отправителе. Именно эти
данные получатель увидит в графе "От кого" пришедшего письма. Каждая
учетная запись может содержать несколько наборов идентификационных
данных. Их можно добавить в разделе Персоналии. Данные раздела персоналий
всех почтовых ящиков отображаются в поле От в окне редактирования письма.

При нажатии на кнопку Изменить, открывается окно редактирования
Персоналии. 
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Данное окно позволяет заполнить данные которые будет видеть получатель, а
также позволяет включить автоматический Запрос уведомления о прочтении.
Данные параметры будут использованы при отправке письма с использованием
этой Персоналии.
Выпадающий список в пункте Сервер исходящей почты позволяет уточнить,
какой SMTP сервер использовать для данной персоналии.
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Вкладка Серверы содержит адреса и параметры серверов входящей и
исходящей почты. При использовании большинства известных почтовых
серверов, EssentialPIM автоматически заполняет эти поля на этапе создания
почтового ящика. Для более редких, либо частных случаев,  параметры
требуется откорректировать вручную. Если вы не уверены в правильности
параметров серверов, обратитесь в раздел помощи вашего почтового
провайдера. Как правило, параметры серверов находятся в разделе часто
задаваемых вопросов (ЧАВО или FAQ).
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Вкладка Настройки позволяет установить ряд параметров для автоматизации
работы с почтой. Набор опций несколько различен для учетных записей POP3
(слева) и IMAP4 (справа), что объясняется спецификой работы данных
протоколов.
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Вкладка Подпись позволяет создать подпись, которая будет автоматически
добавляться к новым письмам. Для каждого почтового ящика или для каждой
отдельной персоналии можно создавать отдельную подпись.

4.8.5 Почтовая рассылка

При помощи EssentialPIM Pro можно осуществить массовую рассылку писем по
заданному шаблону. При этом, для создания письма-шаблона, используются
поля существующих контактов. Таким образом можно создавать 
персонализированные письма любому количеству адресатов.

Создание массовой рассылки в  EssentialPIM Pro

Чтобы создать рассылку, выделите получателей в списке контактов. Для этого
можно воспользоваться сочетанием Ctrl (Shift) + левый клик мыши. Затем
вызовите контекстное мени (правый клик мыши) и выберите пункт Сделать
рассылку. Следует иметь в виду, что список получателей можно
отредактировать позже. Рассылку также можно создать зайдя в меню Сервис -
> Создать рассылку.
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После чего будет открыто окно редактора рассылки.

Данное окно состоит из трех блоков:
- Получатели - здесь можно редактировать список получателей будущей
рассылки.
- Сообщение - здесь создается шаблон сообщения.
- Просмотр - в этом блоке показывается как получатели увидят создаваемое
письмо.
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Блок Сообщения

Данный блок используется для составления шаблона письма для рассылки.
EssentialPIM Pro позволяет использовать поля контактов в качестве тегов
(название поля в <> скобках, например, <Имя>). Для быстрой вставки основных
полей можно воспользоваться кнопкой Вставить на панели инструментов.

В поле Получатель можно вписать имя, используя теги, либо обычный текст,
который будет использован для всех получателей рассылки. Содержимое
данного поля будет добавлено в заголовочную часть письма в поле Кому.
Результат можно наблюдать в блоке Просмотр в поле Кому. 

В выпадающем меню E-mail следует указать какое поле, содержащее адреса
электронной почты, использовать для отправки. 

Основную часть блока сообщения занимает область для составления шаблона
письма. Здесь надо составить непосредственно само письмо, используя текст и
теги.
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Вкладка Вложения позволяет прикрепить дополнительные файлы к письму. 

Блок Получатели

Как только работа над шаблоном закончена и результат в блоке Просмотр вас
устраивает, следует обратить внимание на список получателей. Нажав на
кнопку Получатели, открывается диалог в котором можно добавлять/удалять
получателей.
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Список слева показывает доступные контакты (контакты, у которых заполнено
поле адреса электронной почты). Чтобы добавить или удалить адресатов надо
выделить контакт(ы) и нажать соответствующую кнопку со стрелкой. Чтобы
облегчить поиск необходимых контактов, можно воспользоваться выпадающим
меню Фильтр и полем Найти. Меню Фильтр позволяет показать контакты
только из определенных групп.

При использовании тегов возможна ситуация, когда у некоторых контактов
могут быть не заполнены используемые поля. Такие контакты выделяются в
списке красным цветом. 

Чтобы узнать какой именно информации не хватает, следует навести курсор на
проблемный контакт, после чего незаполненные поля будут видны во
всплывающей подсказке. Чтобы добавить недостающие данные надо открыть
контакт двойным щелчком мыши прямо из списка, либо при помощи команды 
Изменить из контекстного меню контакта. 

Блок Просмотр

Этот блок позволяет видеть конечный результат который получат адресаты. Если
вы убедились, что шаблон написан правильно, можно нажать кнопку Сохранить
и отправить либо Отправить.
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После чего все письма рассылки будут помещены в папку Исходящие почтового
ящика используемого  по умолчанию.

Сохранение шаблона и последующее использование

Чтобы сохранить текущий шаблон рассылки нужно нажать на кнопку Сохранить
проект в левом нижнем углу окна. Чтобы открыть ранее сохраненный проект,
надо нажать кнопку Открыть проект и выбрать необходимый из списка.

4.8.6 Фильтры писем

EssentialPIM Pro позволяет автоматически сортировать входящую и исходящую
почту при помощи Фильтров писем. Зайдите в меню Сервис и выберите пункт
Фильтр писем.
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Нажмите Добавить, чтобы создать новый фильтр. Это откроет диалог
редактировния фильтра.

При помощи кнопок +/- можно добавлять и убирать условия и необходимые
действия. Раздел действий определяет, какие операции будут произведены с
письмом при выполнении условий. В данном примере письмо будет помещено в
папку Google, если поле От кого будет содержать слово Google. Фильтр может
быть применен как к входящим, так и к исходящим сообщениям. Это
определяется выпадающим меню Применить.



Работа с EssentialPIM Pro 101

© 2019 Astonsoft Ltd.

Диалог Фильтры писем предлагает ряд функций для управления фильтрами:

- Фильтры могут быть включены или отключены при помощи чекбокса справа от
названия фильтра.
- Фильтры применяются в порядке очереди определенной значением приоритета
в столбце #. Изменить приоритет можно при помощи кнопок вверх и вниз.
- Фильтры могут быть отсортированы по любому из столбцов, для этого кликните
на заголовок столбца.
- Функция Применить выбранные фильтры для позволяет немедленно
применить фильтр к уже полученным письмам в указанной папке.

Кнопки Экспорт/Импорт позволяют сохранить или загрузить набор фильтров
(может быть использовано для создания резервной копии, либо для переноса
правил в другой файл данных).

4.8.7 Спам фильтр

EssentialPIM Pro предлагает функцию адаптивной фильтрации спама. Программа
учится определять спам в соответствии с вашими действиями.
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Для эффективной работы данной функции, сначала вам потребуется вручную
обучить спам фильтр определять нежелательную почту. Для этого надо просто
отмечать нежелательную почту как спам при помощи соответствующей кнопки
на панели инструментов. Также важно отмечать как не спам сообщения,
которые были ошибочно определены как спам. Кнопка Отметить как Не спам
появляется на панели инструментов при открытии папки со спамом. Чем больше
писем будет отмечено, тем точнее адаптивный фильтр будет определять
нежелательную почту.

По умолчанию спам фильтр отключен и может быть включен отдельно для
каждой учетной записи. Делается это во вкладке Настройки Спама диалога
Настройка почтовых ящиков.

Для дополнительной настройки следует проследовать в общие настройки спам
фильтра. Для этого нажмите кнопку Общие настройки во вкладке Настройки
Спама, либо откройте диалог Сервис -> Настройки программы -> Спам.
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Данный диалог позволяет выставить настройки, которые будут применены ко
всем учетным записям со включенным спам фильтром.

4.8.8 PGP шифрование

Для безопасного обмена сообщениями по электронной почте EssentialPIM Pro
предлагает встроенную функцию PGP шифрования, которая позволяет
зашифровывать переписку и добавлять цифровую подпись.

Принцип работы PGP шифрования

PGP использует принцип шифрования открытым ключом. В данной системе у
каждого пользователя есть пара ключей: открытый (публичный) ключ для
шифрования и закрытый (личный) - для дешифровки. Каждая пара ключей также
содержит под-ключи: один для шифрования и один для цифровой подписи.
Открытый ключ также может иметь цифровую подпись. Цифровая подпись ключа
сообщает получателям, что идентификационные данные отправителя сообщения
верны. Цифровая подпись ключа отражается в сертификате ключа. Более
подробно о ключах и структуре сертификатов можно узнать в разделе 
Управление PGP ключами.

Итак, система работает следующим образом. Человек, решивший получать
письма в зашифрованном виде, создает пару PGP ключей - открытый и закрытый.
Открытый ключ раздается всем корреспондентам, с помощью него они смогут
зашифровывать письма перед отправкой владельцу ключа. Следует иметь в
виду, что открытым ключом можно только зашифровать письмо. Получив
зашифрованное письмо, владелец ключа расшифровывает его своим закрытым
ключом. Более подробно о шифровании и расшифровывании в EssentialPIM можно
узнать здесь.

PGP также поддерживает идентификацию и проверку целостности письма
посредством цифровой подписи. По умолчанию цифровая подпись используется
в сочетании с шифрованием, но она может использоваться и отдельно. Подпись
служит для установления было ли письмо отправлено отправителем, а также не
было ли изменено содержимое письма после отправки.

4.8.8.1 Как отправлять и получать зашифрованные письма

Чтобы использовать шифрование и/или цифровую подпись по стандарту OpenPGP
необходимо либо создать пару PGP ключей и разослать корреспондентам свой
открытый ключ (для того, чтобы у них имелась возможность шифровать письма,
адресованные вам), либо импортировать открытые PGP ключи от других людей
(чтобы иметь возможность отправки им зашифрованных писем). Обе операции
могут быть осуществлены при помощи Мастера настройки PGP в меню Сервис.
Мастер проведет вас через процесс создания/импорта пары PGP ключей или
импорта открытых ключей.

Первый шаг мастера описывает общие принципы работы PGP.
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На втором шаге предлагается выбрать между созданием новой пары открытого и
закрытого PGP ключей и импортом существующего ключа.

Создание нового набора PGP ключей

Если вы выбрали создание новой пары ключей, в первую очередь мастер
предлагает указать для какой Персоналии создается ключ.
Также следует указать пароль, которым будет защищен ключ.
Кнопка Настройки позволяет установить дополнительные параметры ключа
(можно оставить значения по умолчанию).

Тип ключа - позволяет выбрать алгоритм шифрования и цифровой подписи.
Предлагается два варианта: RSA и Elgmal/DSS. При выборе RSA алгоритма, он
используется как для шифрования, так и для цифровой подписи. В случае
Elgmal/DSS, Elgmal используется для шифрования, а DSS - для подписи.
Размер ключа - позволяет выбрать длину ключа. Большая длина ключ
обеспечивает более надежную защиту. Однако, следует иметь в виду, что
длинный ключ может вызвать значительные задержки при зашифровывании/
расшифровывании.
Истекает - здесь устанавливается срок действия ключа. По истечении срока
действия потребуется новая пара ключей, личный ключ больше не сможет
расшифровывать письма, а общий - зашифровывать.

Следующий шаг мастера предлагает экспортировать открытый ключ в *.pgp
файл для его последующего распространения.

Импорт PGP ключей

http://en.wikipedia.org/wiki/RSA_%28cryptosystem%29
http://en.wikipedia.org/wiki/ElGamal_encryption
http://en.wikipedia.org/wiki/Digital_Signature_Standard
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Если выбрано не создание, а импорт ключа, то следующим шагом будет 
предложено импортировать ключ. Для этого надо нажать кнопку Обзор и
выбрать файл содержащий пару ключей (открытый и закртытый), либо файлы
открытых ключей от людей с которыми вы планируете переписываться.

Как только импортированы открытые ключи, появляется возможность отправлять
зашифрованные сообщения владельцам ключей. Чтобы зашифровать
создаваемое сообщение, нужно зайти в меню PGP и включить параметр
Зашифровать письмо. Письмо будет автоматически зашифровано при нажатии
кнопки Отправить. Все вложения при этом также будут зашифрованы.

Наличие личного PGP ключа позволяет добавить к письму цифровую подпись.
Для получателя подпись будет гарантом того, что письмо пришло именно о вас.
Чтобы добавить цифровую подпись в электронное сообщение нужно в меню PGP
активировать параметр Подписать письмо.

Когда приходит зашифрованное сообщение, EssentialPIM пытается расшифровать
его автоматически при попытке прочтения. Зашифрованные письма можно легко
заметить по иконке в виде замка.

Если ваш PGP ключ защищен паролем, то программа запросит ввести пароль при
попытке прочитать зашифрованное письмо.
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Помнить пароль на Х минут - этот параметр позволяет определенное время
расшифровывать письма без дополнительного запроса пароля. Функция полезна
когда предстоит прочитать несколько зашифрованных писем.

Когда письмо успешно расшифровано, EssentiaalPIM добавляет
соответствующую надпись в заголовочную часть письма - Расшифрованное
письмо.

Если письмо было подписано цифровой подписью и подпись была подтверждена,
то в заголовочную часть добавляется следующая запись:

Если расшифровка не удалась по какой-либо причине, будь то неправильный
пароль или отсутствие соответствующего ключа, то в заголовок добавляется
следующее сообщение:

4.8.8.2 Управление PGP ключами

Большинство операций с PGP ключами, такие как создание, импорт/экспорт,
шифрование сообщений могут быть осуществлены при помощи мастера, либо
команд меню. Помимо этого, EssentialPIM Pro предоставляет встроенный
инструмент для управления PGP ключами, доступный через меню Сервис ->
Управление ключами PGP.
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Главное окно отображает список доступных ключей и их под-ключей, а также
предоставляет инструменты для работы с ними. 

Показать ключи других адресатов - когда данный параметр включен,
отображаются как собственный ключи, так и импортированные открытые ключи
других пользователей.

Файл
Новый ключ - открывает диалог создания новой пары ключей.

Данный диалог предлагает установить те же параметры, что и Мастер настройки
PGP.

Импорт ключей - импортирует закрытые (личные) и/или открытые ключи из
внешнего файла. Используйте эту функцию, чтобы импортировать открытые
ключи полученные от других пользователей.
Экспорт открытого ключа - экспортирует ваш открытый ключ в *.pgp файл.
Рассылка такого файла является одним из способов распространения вашего
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открытого ключа среди людей с которыми планируется вести зашифрованную
переписку.
Экспорт закрытого и открытого ключей - экспортирует как закрытый, так и
открытый ключи в один файл. Используйте эту функцию только для резервного
копирования ключа и никогда никому его не давайте.

Правка
Скопировать открытый ключ в буфер обмена - данная функция может быть
использована для рассылки открытого ключа. После копирования, вставьте
ключ в тело письма, после чего в письме появится подобный блок:

Импорт ключа из буфера обмена - данная функция противоположна
предыдущей. Скопировав ключ в буфер обмена (например, из тела письма)
можно воспользоваться данной функцией чтобы добавить ключ в хранилище.
Отозвать ключ - данная команда делает определённый ключ
недействительным. Открытый ключ со статусом "отозванный" также становится
недействительным и не может больше использоваться для шифрования писем.
Соответствия адресов почты - добавляет дополнительные адреса
электронной почты в открытый ключ. Таким образом, данный ключ будет
использоваться при шифровании ваших сообщений, в адресатах которых указан
хотя бы один из дополнительных адресов.

Действия
Отослать открытый ключ - создает новое сообщение с вложенным открытым
ключом. Данная функция является простым и быстрым способом рассылки
своего открытого ключа.

4.8.9 Решение проблем с почтой

1. Socket Error 
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Данная ошибка возникает в том случае, когда EssentialPIM не может
соединиться с почтовым сервером. В большинстве случаев причиной являются
неправильные адреса серверов входящей либо исходящей почты. Более редкой
причиной является блокировка программы брандмауэром.

Пути решения:
1. Откройте настройки серверов через Сервис -> Почтовые ящики ->
Изменить -> Серверы, затем исправьте необходимые параметры. В случае,
если вы не в курсе, что именно надо исправить, зайдите в ваш почтовый ящик
через веб-интерфейс и обратитесь к разделу помощи вашего почтового
провайдера. Вам надо найти настройки POP3/IMAP4 (для входящей почты) и
SMTP (для исходящей почты) серверов.

2. Добавьте EssentialPIM в исключения в настройках межсетевого экрана.

4.9 Пароли

4.9.1 Работа с паролями

Модуль Пароли представляет собой хранилище и менеджер данных учетных
записей для различных сервисов. Инструментарий модуля позволяет хранить
детали учетных записей, генерировать пароли, упорядочивать записи по
группам, всё это делает его незаменимым помощником в ежедневной работе.

Добавление записи

Новый пароль может быть добавлен несколькими способами. Самый быстрый -
это нажать кнопку Добавить запись на панели инструментов. Либо через
меню Действия -> Новая запись Паролей.

Пароль также можно создать двойным щелчком мыши по пустой части рабочей
области модуля Пароли. При использовании обоих способов, открывается окно
редактирования записи пароля, в котором можно указать логин, пароль, адрес
сервиса и прочие данные. Более подробно параметры записи рассмотрены в
теме Редактирование паролей.



EssentialPIM Pro файл помощи110

© 2019 Astonsoft Ltd.

Ins - горячая клавиша для добавления новой записи пароля.
Shift+Ctrl+Р - глобальное сочетание клавиш для добавления новой
записи (работает даже когда окно программы не активно в данный
момент)
Пароль также можно добавить через меню Файл -> Новый -> Запись
Паролей

Создание групп

При наличии большого количества паролей, рано или поздно возникает
необходимость их структурировать. EssentialPIM Pro предлагает использовать для
этого группы паролей.

Список групп находится слева от списка паролей и представляет собой
древовидную структуру папок. Чтобы создать группу, нужно нажать кнопку со
стрелкой вниз рядом с кнопкой Добавить запись и выбрать Добавить группу
на панели инструментов либо через меню Действия -> Новая группа.

После чего будет открыто диалоговое окно свойств группы.

Имя - название создаваемой группы. 
Выбрать иконку - позволяет присвоить группе иконку из имеющихся
вариантов, либо указать внешний файл из которого следует загрузить иконку.
Статус - позволяет установить статус группы - личный, либо публичный.
Только чтение - отключает/включает возможность редактирования
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содержимого группы.

Группы паролей могут быть упорядочены в иерархическую структуру.
Инструменты для этой функции не вынесены на панель действий. Тем ни менее,
группы можно перемещать между собой и делать их подруппами других групп.
Чтобы отредактировать структуру групп, нужно перетащить требуемую группу,
удерживая левую кнопку мыши, на нужную позицию. Во время перетаскивания
курсор будет подсвечивать куда попадет группа. Чтобы сделать группу
дочерней, нужно перетащить ее на название будущей родительской группы, как
только родительская группа станет подсвеченной, можно отпустить левую
кнопку мыши.

Управление записями паролей

Чтобы поместить пароль в ту или иную группу, можно просто перетащить его на
название группы, удерживая левую кнопку мыши. Пароль может быть частью
нескольких групп, для этого его можно перетащить тем же способом в разные
группы. Чтобы убрать пароль из группы, либо отредактировать набор групп в
которых должен находиться пароль, можно воспользоваться полем Группы в
диалоге информации о пароле.

В этом поле, через запятую, перечислены группы членом которых является
данный пароль. Список можно отредактировать вручную, либо, чтобы избежать
опечаток, нажать кнопку с тремя точками в конце строки. Это вызовет
диалоговое окно, в котором можно отредактировать членство пароля. Галочками
следует отметить принадлежность записи к группам.

Стоит заметить, что при размещении пароля в разных группах, сама
запись не копируется и остается в базе в единственном экземпляре.
Объясняется это тем, что группы хоть и похожи на папки, но работают
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несколько иначе нежели папки в Windows. Группы в EssentialPIM Pro
больше походят на параметр сортировки,  нежели папки в их
классическом понимании.

Использование паролей

Чтобы воспользоваться учетными данными из модуля Пароли, достаточно
установить курсор в поле логин/имя пользователя в веб браузере или нужной
программе, затем воспользоваться командой Автовставка из контекстного
меню записи пароля.

Если вышеуказанный способ по какой-либо причине не работает, то можно
скопировать логин/пароль в буфер обмена, затем вставить в соответствующие
поля. Для ускорения процедуры достаточно сделать двойной клик левой
кнопкой мыши по необходимому полю в рабочей области модуля, либо по
названию поля в нижней части экрана, после чего значение поля будет
скопировано в буфер обмена.

Как только данные пароля попадают в буфер обмена, в строке состояния
появляется соответствующее сообщение.

При этом, из соображений безопасности, включается обратный отсчет (60
секунд по умолчанию), по истечении которого буфер обмена автоматически
очищается.
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4.9.2 Редактирование паролей

Записи паролей могут быть отредактированы в любой момент. Быстрое
редактирование возможно напрямую в рабочей области модуля Пароли. Список
записей представлен в виде таблицы, для редактирования данных нужно
выделить необходимую ячейку и сделать одиночный левый клик мыши, после
чего можно ввести/отредактировать данные. В нижней части рабочей области
можно напрямую редактировать данные выделенной записи и добавить 
вложения.

Для более детального редактирования записей, можно воспользоваться окном
редактирования пароля. Диалоговое окно редактирования данных пароля
открывается двойным кликом левой кнопки мыши.

1. Кнопка добавления дополнительного поля.
2. Инструменты управления доступа к паролю. Позволяют сделать проль
доступным только для чтения и изменить его статус. Данные параметры влияют
на различные аспекты доступа, отображения, синхронизации и защиты данных.
Поле Статус также используется в EssentialPIM Pro Бизнес для назначения
записей другим пользователям. Более подробно о назначении записей и статусах
можно прочитать здесь.
3. Основные данные о записи, такие как логин, пароль, название и адрес
ресурса, а также дополнительные пользовательские данные.
4. Область заметок представляет собой простой текстовый редактор с базовыми
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инструментами форматирования текста.
5. Здесь можно добавить теги. Более подробно о работе с тегами можно
прочитать здесь.

Для создания уникального пароля можно воспользоваться генератором паролей,
нажав на кнопку Ген. При этом будет вызван диалог генерации пароля.

Здесь можно задать какие символы будут использоваться при создании пароля и
его длину.

Вкладка Связанные записи содержит список записей в которых есть ссылка на
данную запись пароля.

Настройка полей

EssentialPIM Pro позволяет добавлять и редактировать поля в модуле Пароли.
Для того, чтобы внести изменения в структуру полей, нужно открыть диалог
редактирования любого пароля и воспользоваться следующими инструментами.
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Следует иметь в виду, что все изменения в структуре полей
применяются ко всем записям паролей в базе, не зависимо от того для
какой записи было сделано изменение.

4.10 Работа по сети

EssentialPIM Pro Бизнес версия предлагает широкие возможности совместного
использования единой базы данных для малых и средних групп пользователей.
Бизнес версия предоставляет одновременный доступ нескольким пользователям
ко всем модулям EssentialPIM Pro за исключением почты. Каждый пользователь
может создавать как публичные, так и приватные записи, назначать записи
другим пользователям, редактировать категории. При необходимости права
пользователей могут быть ограничены, например, только чтением. Все изменения
сделанные одним пользователем немедленно становятся видимы остальным
членам группы в соответствии с их правами доступа.

Ниже проиллюстрирован принцип построения работы бизнес версии.
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Основная база данных (файл *.epim) располагается на сервере, а машины с
установленной клиентской частью программы (EssentiaPIM Pro), подключаются к
базе. В качестве сервера может быть использован любой компьютер, на котором
установлен Firebird сервер. Установка EssentialPIM Pro клиента на сервер не
является обязательным условием, но возможна. Компьютер, используемый в
качестве сервера, может подключаться к базе точно также как и клиентские
компьютеры. 

Подключение к базе данных возможно, как по локальной сети (LAN), так и через
VPN и Интернет.  

4.10.1 Подключение к серверу

Установка всего необходимого для создания соединения EssentialPIM Pro Бизнес
с сервером не требует от пользователя специальных навыков и дополнительных
настроек сети.

Для работы по сети требуются следующие составляющие:

- установленный сервер Firebird на сервере
- EssentialPIM Pro клиент 
- файл базы данных *.epim на сервере

Firebird сервер включен в установщик EssentialPIM Pro Бизнес. 
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Во время установки бизнес версии предлагается выбор устанавливаемых
компонентов - Firebird server и EssentialPIM Pro.

Firebird следует устанавливать только на компьютер который будет выступать в
качестве сервера. При установке на клиентских компьютерах, опцию Firebird
server можно отключить.

После установки сервера нужно создать файл данных *.epim, к которому будет
производиться подключение, и разместить его на сервере в любой директории.
Можно также использовать имеющийся файл базы данных, для этого просто
скопируйте его на сервер.

Как только подготовительные этапы завершены, можно приступить
непосредственно к подключению клиента EssentialPIM Pro к базе данных:

1. Запустите EssentialPIM Pro. Если программа уже запущена, то закройте в ней
открытую базу данных нажав значок крестика в правом верхнем углу рабочей
области окна, либо через меню Файл -> Закрыть.

2. Зайдите в меню Файл -> Соединение с сервером, после чего заполните
диалог соединения с сервером:
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Сервер - здесь вводится имя компьютера, выступающего в роли сервера, либо
его сетевой IP адрес. При подключении через VPN или Интернет, соединение
возможно только по IP адресу. Нажав кнопку с тремя точками, можно указать
какой компьютер является сервером в локальной сети.
Файл - локальный путь к файлу данных на сервере. Путь не должен содержать
сетевого имени сервера, либо сетевого диска (например, если файл на сервере
расположен по адресу "D:\EPIM_Metwork_base\database.epim", то точно такой же
путь должен быть введен и на всех клиентских машинах).
Логин/Пароль - здесь вводятся имя и пароль пользователя. При первом
подключении к базе необходимо использовать предустановленную учетную
запись администратора: логин - SYSDBA, пароль - masterkey.

3. После нажатия кнопки ОК, инициируется соединение с базой данных. Если на
данном этапе возникла ошибка, обратитесь к теме Разрешение проблем.

4. После установки соединения с сетевой базой, становится доступным меню 
Сервис -> Пользователи, где можно создавать, удалять и редактировать
учетные записи пользователей. Более подробно это рассмотрено в теме 
Управление пользователями.

5. После создания учетных записей пользователей, можно установить
EssentialPIM Pro на другие компьютеры и произвести соединение с сервером по
принципы, описанному выше.

Если в качестве сервера используется ПК под операционной системой
не входящей в семейство Windows, то необходимо будет установить
соответствующую версию Firebird сервера с сайта разработчика.

При подключении через VPN или Интернет в поле Сервер надо указать
IP адрес сервера. Соответственно для VPN сети внутренний адрес в VPN
сети, при соединении через Интернет - внешний IP адрес. 

http://www.firebirdsql.org/en/downloads/


Работа с EssentialPIM Pro 119

© 2019 Astonsoft Ltd.

4.10.2 Управление пользователями

Вносить какие-либо изменения в настройки пользователей можно лишь зайдя в
базу данных под учетной записью администратора. По умолчанию EssentialPIM
Pro создает учетную запись администратора с логином SYSDBA и паролем
masterkey. С правами администратора становится доступным меню Сервис ->
Пользователи, которое открывает диалог администрирования пользователей.

Вкладка Пользователи содержит список уже созданных учетных записей
пользователей. При помощи чекбоксов можно включать/отключать учетные
записи.
Удалить - удаляет выделенную учетную запись.
Вкладка Активные пользователи - показывает список пользователей которые
в данный момент подключены к базе данных. Данная функция полезна для
отслеживания числа подключений. Например, если один из пользователей
открыл клиент дважды, это будет видно в списке активных пользователей.

Кнопки Добавить, либо Изменить вызывают диалог редактирования учетной
записи. В первом случае создается новая учетная запись, во втором -
редактируется существующая.

Логин/Пароль - здесь вводятся логин и пароль которые пользователь будет
вводить при подключении к базе.
Имя - данное поле не является обязательным, но для эффективного
взаимодействия пользователей весьма желательно, так как именно это имя
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будут видеть другие пользователи при назначении записей.
Обычный доступ - создает пользователя с правами доступа к своим объектам
и публичным записям других пользователей.
Доступ к данным всех пользователей - создает пользователя с частичными
администраторскими правами. Такой пользователь имеет все права обычного
доступа, плюс доступ к записям, созданным другими пользователями, за
исключением почты.
Только чтение - данная опция ограничивает доступ пользователя только
чтением доступных записей, создавать новые и редактировать имеющиеся
пользователь не сможет.
Разрешено изменение категорий - разрешает пользователю редактировать
набор категорий в базе.
Разрешено изменение полей - разрешает создавать и изменять поля в базе
(актуально для модулей Дела, Контакты, Пароли).
Разрешено изменение иконок - разрешает добавлять дополнительные иконки
для заметок и паролей.

Пользователь SYSDBA имеет права доступа к записям всех
пользователей. Помимо этого, только пользователь SYSDBA имеет право
редактировать пользователей, а также обновлять базу данных с
выходом новой версии EssentialPIM.

4.10.3 Назначение и установка статусов записей

Неотъемлемой частью работы в группе является эффективный обмен
информацией между членами команды. В EssentialPIM Pro Бизнес каждый
пользователь (в соответствии с правами) может создавать записи видимые для
всех пользователей, только для себя, а также назначать записи определенным
пользователям.

За управление статусом записи и назначением другим пользователям отвечает
поле Статус, оно присутствует в любой записи.

Статус Общий делает запись доступной всем пользователям базы данных (если
это не противоречит правам доступа других пользователей).
Статус Личный делает запись доступной только создавшему ее пользователю.
Выбор пользователей позволяет назначать запись конкретным пользователям
группы.
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Список Выбранные пользователи показывает кому будет доступна запись.
Пользователей можно добавлять и удалять из списка при помощи кнопок со
стрелками влево, вправо.
Опция Все текущие и новые пользователи делает запись доступной не только
всем существующим пользователям, но всем тем, которые будут созданы в
будущем.

Следует иметь в виду, что пользователи с правами администратора
будут иметь доступ ко всем записям в независимости от статуса и
ограничений. Исключение составляет только модуль почты, он доступен
только хозяину учетной записи.

4.10.4 Решение проблем

При несоблюдении некоторых инструкций подключения, а также по ряду
внешних причин, клиент EsentialPIM Pro может выдать ошибку при подключении к
базе. Ниже рассмотрены наиболее частые случаи и пути их решения.

1. Unable to complete network request to host
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Причина данной ошибки в том, что клиент EssentialPIM Pro не может соединиться
с сервером.

Пути решения:
1. Убедитесь, что Firebird запущен на сервере и работает. Откройте диспетчер
задач, включите опцию Отображать процессы всех пользователей, в
списке процессов должны присутствовать процессы fbserver.exe и fbguard.exe.
Если процессы отсутствуют, установите Firebird как это описано в инструкции
соединения.

2. Проверьте настройки фаервола. Чтобы клиент EssentialPIM Pro мог общаться с
сервером в брандмауэре должны быть открыты следующие порты:
- на сервере для fbserver.exe:
       - входящие: 3050 и 3051 
       - исходящие : весь диапазон (fbserver использует случайный диапазон
портов при обработке событий)
- на клиентском ПК для EssentialPIM.exe:
       - входящие: весь диапазон
       - исходящие: 3050 и 3051

2. Error while trying to open file. Системе не удается найти указанный путь

В данном случае клиент EssentialPIM Pro соединился с сервером, но файл базы
данных отсутствует по указанному пути. 
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Пути решения:
1. Путь к файлу базы не должен быть построен через сетевой интерфейс, т.е.
через имя компьютера, IP адрес, или сетевой диск. Путь должен быть локальным
путем к базе на сервере. Например, если путь к файлу на сервере
"D:\EPIM_Network_base\Net_test.epim", то точно такой же путь должен быть
введен и на клиентских компьютерах.

2. Убедитесь, что нет опечатки в пути к базе. Чтобы минимизировать риск
опечатки, поместите базу данных в папку с коротким именем.

3. Error while trying to open file. Процесс не может получить доступ к
файлу.

Данная ошибка возникает при попытке подключиться к базе, которая открыта на
сервере локально через меню Файл -> Открыть.  В этом случае EssentialPIM Pro
на сервере эксклюзивно занимает файл и не дает подключиться к базе по сети.

Пути решения:
1. Закрыть EssentialPIM Pro на сервере.

2. Чтобы избежать подобной ситуации в дальнейшем, всегда подключайтесь к
базе через Файл -> Соединение с сервером, несмотря на то, что файл базы
данных находится на этом же компьютере.

Если ничего из вышеперечисленного не помогло, обратитесь, пожалуйста в
нашу службу поддержки.

4.11 Печать

EssentialPIM Pro позволяет выводить информацию на печать в удобной для
последующего прочтения форме. По умолчанию на печать выводится тот модуль
и тот вид, которые отображаются на экране в данный момент. Для вывода
данных на печать, зайдите в меню Файл -> Печать с просмотром. Чтобы
изменить параметры печати зайдите в меню Файл -> Печать. Каждый модуль
имеет разные параметры печати. Ниже рассмотрено, какие параметры доступны
для каждого из модулей.
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Сегодня

Модуль Сегодня выводится на печать в том же виде как и представлен на
экране.

Календарь

Существует несколько вариантов печати календаря: по дням, неделям, месяцам
и в табличном виде. В разделе Диапазон печати можно указать диапазон дат, а
для дневного и недельного вида время начала и конца дня, выводимое на
печать. В области Параметров печати можно можно установить цветную, либо
черно-белую печать, а нажав кнопку Категории можно указать задачи из каких
категорий будут напечатаны.

Дела

Для диапазона печати можно выбрать все отображаемые в данный момент дела,
либо только выделенный набор дел.  В области Параметров печати можно
можно установить цветную, либо черно-белую печать, включить/отключить
печать пустых полей, а нажав кнопку Категории или Поля можно указать какие
категории и поля будут выведены на печать.

Заметки 

На печать можно вывести весь список заметок активного в данный момент
дерева, только выделенные заметки, либо только выделенную часть текста
заметки. Перечисленные опции можно выбрать в области Диапазон печати. 

Контакты

Контакты можно напечатать таблицей, либо в виде карточек. Для диапазона
печати могут быть выбраны все контакты отображаемые в данный момент в
модуле Контакты, либо только выделенные. В области Параметров печати
можно можно установить что печатать - контакты или группы, а нажав кнопку
Поля, можно указать какие поля будут напечатаны.

Пароли

При печати паролей, также можно вывести на печать все, либо выделенные
пароли и указать поля для печати.

Для быстрого вывода на печать любой записи в базе данных, можно
воспользоваться командой Быстрая печать из контекстного меню по
правой кнопке мышки.
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4.11.1 Этикетки и конверты

EssentialPIM Pro позволяет печатать этикетки и конверты, используя данные
модуля Контакты. Для вызова мастера создания шаблона для печати этикеток
или конвертов, нужно зайти в меню Сервис -> Печать Этикеток (Печать
Конвертов). Алгоритм работы обеих функций идентичен, рассмотрим работу
мастера на примере печати конвертов.

Итак, зайдя в меню Сервис -> Печать Конвертов, будет вызвано окно мастера
печати конвертов.

На первом шаге предлагается выбрать для каких контактов будут создаваться
конверты - для всех, либо только выделенных в данный момент. Если конверты
печатались ранее и был сохранен шаблон, то его можно использовать, нажав
кнопку Загрузить шаблон.
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На втором шаге выберите формат конверта из предложенного списка. Также на
этом шаге можно отредактировать положение областей адресов в шаблоне
конверта.

На третьем шаге необходимо заполнить адресные данные. В блоке Получатель
можно составить шаблон, по которому будет составлен адрес, используя данные
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контактов. Чтобы вставить какое-то поле из контактов, нужно вызвать
выпадающее меню Вставить и выбрать необходимое поле из списка. После
этого поле будет вставлено в виде тэга. Затем в поле Отправитель введите
ваш обратный адрес. После заполнения всех данных можно нажать кнопку 
Просмотр, чтобы убедиться, что все конверты будут напечатаны как надо. 

Данный шаг также позволяет сохранить все введенные данные как шаблон. Для
этого нужно нажать кнопку Сохранить шаблон и указать имя сохраняемого
файла. В шаблоне сохраняется как список контактов, так и адресные данные.

Как только все данные введены, можно нажать кнопку Далее. На четвертом
шаге можно указать некоторые дополнительные параметры печати и подтвердить
вывод на печать.

4.12 Импорт/Экспорт данных

4.12.1 Импорт

Все данные импортируются в EssentialPIM через меню Файл -> Импорт ->
"Модуль" -> "Тип данных". В данном разделе представлено описание
форматов данных, поддерживаемых при импорте. 

Календарь

- iCal формат. Календарь может быть импортирован из календаря iCal (*.ics). Это
распространенный формат множества различных онлайн сервисов и программ.
Этот формат удобно использовать для импорта праздников, загрузив из
Интернета соответствующий файл календаря. Диалог импорта позволяет
указывать путь как к файлам, расположенным в Интернете, так и к локальным
*.ics файлам. 
- CSV, импортирует события из *.csv файла. Данный формат является
стандартным для широкого круга приложений. Более подробно о процессе
импорта можно прочитать тут.
- EPIM, импортирует события календаря из другого *.epim файла. 

Вы можете пописаться на публичные или доступные вам календари при
помощи функции Подписка на календарь.

iCal календарь может быть добавлен путем перетаскивания iCal (*.ics)
файла в область модуля Календарь.

Дела 

- iCal формат. Списки дел могут быть импортированы из *.ics файла, аналогично
календарю. Также поддерживается импорт как из Интернета, так и из
локального файла.
- CSV, импортирует дела из *.csv файла. Данный формат является стандартным
для широкого круга приложений. Более подробно о процессе импорта можно
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прочитать тут.
- EPIM, импортирует дела из другого *.epim файла. Дела при этом
импортируются полностью как они есть в импортируемом файле, сохраняя при
этом древовидную структуру.

Заметки

- RTF/TXT, файлы *.rtf и *.txt импортируются в одну заметку, все данные
помещаются на один лист.
- TreePad, импорт из программы TreePad, с сохранением иерархической
структуры заметок.
- KeyNote, импорт из программы KeyNote, с сохранением древовидной структуры
заметок.
- EPIM, импортирует заметки из другого *.epim файла. Заметки при этом
импортируются полностью как они есть в импортируемом файле, сохраняя при
этом древовидную структуру.

Контакты

- vCard импортирует контакты из *.vcf файлов. Контакты помещаются в группу,
которая была выбрана в момент импорта.
- CSV, импортирует контакты из *.csv файла. Данный формат является общим
для широкого круга приложений. Более подробно о процессе импорта можно
прочитать тут.
- EPIM, импортирует контакты из другого *.epim файла. Контакты при этом
импортируются полностью как они есть в импортируемом, сохраняя при этом
свою структуру.

Пароли

- CSV, процесс импорта паролей из *.csv файла анологичен импорту контактов,
описанному выше.
- Roboform HTML позволяет импортировать файлы в формате *.html, созданные
программой Roboform.
- KeyPass XML, позволяет импортировать файлы в формате *.xml созданные
программой KeyPass.
- CSV, импортирует пароли из *.csv файла. Данный формат является общим для
широкого круга приложений. Более подробно о процессе импорта можно
прочитать тут.
- EPIM, импортирует пароли из другого *.epim файла. Пароли при этом
импортируются полностью как они есть в импортируемом, сохраняя при этом
свою структуру.

Почта

- EML, импортирует письма из *.eml файлов. Импортированные письма
помещаются в выделенную на момент импорта папку.

Импорт из Outlook 
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EssentialPIM поддерживает импорт данных из *.pst файлов MS Outlook. При
импорте можно указать какие модули подлежат импорту. Поддерживается также
импорт почты, при этом в диалоге импорта надо указать в какой почтовый ящик
EssentalPIM следует импортировать письма. Если опция импорта почты
неактивна, значит в EssentialPIM еще не создано ни одно почтового ящика.
Создайте ящик как это описано в теме Создание почтового ящика.

Импорт из EPIM

Позволяет импортировать все данные (за исключением почты) из другого *.epim
файла. Все данные импортируются в точности как они представлены в
импортируемом файле сохраняя при этом структуру и внутренние ссылки между
собой.

4.12.1.1 Импорт из CSV

EssentialPIM Pro позволяет импортровать записи календаря, дел и контактов из
файлов в формате CSV.

После выбора файла для импорта открывается следующее диалоговое окно.

Главная задача данного диалога - согласование полей исходного файла с
полями контактов в EssentialPIM. В случае, когда заголовок таблицы содержит
названия столбцов в исходном файле, можно включить параметр "Первая строка
файла содержит названия столбцов" в верхней части окна, после чего
программа сама перераспределит поля в соответствующие поля EssentialPIM и
создаст необходимые дополнительные поля.

В случае, когда исходный файл не содержит заголовков, поля необходимо
назначить вручную. Для этого нужно выделить колонку с данными исходного
файла и указать соответствующее ему поле из выпадающего списка Импорт в,
после чего заголовок изменится на соответствующее поле в EssentialPIM.
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Немаловажным также является установка правильного символа разделителя. По
умолчанию EssentialPIM предлагает использовать символ ";", указанный в поле 
Разделитель, но формат CSV позволяет использовать различные символы в
качестве разделителя и в исходном файле он может быть другим. Это сразу
будет видно в окне импорта - все данные будут находится в одном столбце.
Чтобы таблица прочиталась корректно и колонки разделились, необходимо
сначала выяснить какой символ используется в исходном файле в качестве
разделителя. Это можно выяснить или открыв файл в блокноте Windows или
попробовав вводить наиболее часто встречающиеся символы в поле 
Разделитель (обычно это точка, запятая или двоеточие). EssentialPIM
автоматически разобьёт данные на колонки при указании правильного символа-
разделителя.

Как только все поля назначены можно нажать кнопку ОК, после чего контакты
будут импортированы.

4.12.2 Экспорт

EssentialPIM позволяет экспортировать данные в различные форматы, что
упрощает процесс переноса данных в сторонние программы или сервисы, когда
это необходимо. В общем виде экспорт данных доступен через меню Файл ->
Экспорт -> "Название модуля" -> "Формат данных". Ниже рассмотрены
поддерживаемые форматы данных по каждому модулю.

Календарь

- HTML - экспортирует календарь в *.html файл, который можно открыть при
помощи браузера, либо выложить в Интернет. Диалог экспорта позволяет
указать диапазон дат и вид календаря (день, неделя, месяц). Нажав кнопку 
Категории, можно указать события каких категорий включать в экспортируемый
файл.
- iCal - экспортирует в *.ics файл, одни из наиболее часто используемых
форматов для календаря. Диалог экспорта позволяет экспортировать весь
календарь, текущий день/неделю/месяц/год, либо указать диапазон дат. Нажав
кнопку Категории, можно указать события каких категорий включать в
экспортируемый файл.
- CSV - экспортирует в *.csv файл. Это простой табличный формат с
разделителями. Файл данного типа может быть открыт в любом табличном
процессоре. Параметры экспорта аналогичны экспорту в iCal.
- EPIM - экспортирует данные календаря в другой *.epim файл, при этом это
может быть как существующий, так и новый файл.

Дела

- HTML - дела экспортируются в виде таблицы в *.html файл. Окно экспорта
позволяет экспортировать весь список имеющихся дел, только видимых в
данный момент в окне модуля (удобно при экспорте результатов выборки), либо
только выделенные дела. Кнопки Категории и Поля позволяют выбрать дела
каких категорий и какие поля в делах включать в экспорт.
- iCal - список дел экспортируется в *.ics файл. Параметры экспорта
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аналогичны параметрам HTML, за исключением набора полей. В iCal
экспортируется только стандартный набор полей.
- CSV - дела экспортируются в *.csv таблицу. Параметры экспорта аналогичны
параметрам HTML.
- EPIM - экспортирует дела в другой *.epim файл, при этом это может быть как
существующий, так и новый файл. Структура экспортируемых дел при этом
сохраняется.

Заметки

- HTML, RTF, DOCX - заметки экспортируются, соответственно, в *.html, *.rtf,
*.docx файлы. При экспорте сохраняется форматирование заметок. 
- TXT - экспорт в *.txt файл. Форматирование при этом теряется.
- EPIM - экспортирует заметки в другой *.epim файл, при этом это может быть
как существующий, так и новый файл. Структура экспортируемых заметок при
этом сохраняется.

Контакты

- CSV - контакты экспортируются в *.csv таблицу. Затем файл может быть
открыт в любом табличном процессоре. Экспортировать можно как список
контактов, так группы.

Экспортировать можно весь список, видимые, либо только выделенные
элементы. Нажав кнопку Поля, можно указать какие поля включать в экспорт.

- HTML - контакты экспортируются в *.html файл в виде карточек контактов.
- RTF, TXT - контакты экспортируются в *.rtf и *.txt файлы. Контакты и группы
экспортируются списком.

При экспорте контактов в HTML, RTF, TXT EssentialPIM Pro предлагает
следующие параметры:
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В экспортируемый список может быть включен как список контактов, так и
список групп. Нажав кнопку Поля, можно указать какие поля включать в
экспорт.

- vCard - экспортирует контакты в *.vcf файлы. Для каждого контакта
создается отдельный файл. Экспортируются только поля, предусмотренные
vCard форматом.

- EPIM - экспортирует контакты в другой *.epim файл, при этом это может быть
как существующий, так и новый файл. Структура экспортируемых контаков при
этом сохраняется.

Пароли

- CSV - список паролей экспортируются в *.csv таблицу.
- EPIM - экспортирует пароли в другой *.epim файл, при этом это может быть
как существующий, так и новый файл. Структура экспортируемых паролей при
этом сохраняется.

Почта

- EML - письма экспортируются в *.eml файлы. Каждое письмо экспортируется в
отдельный файл.

Экспорт в Outlook

EssentialPIM Pro позволяет экспортировать данные в Outlook. Диалог экспорта
позволяет экспортировать модули Календарь, Дела, Заметки и Контакты. Для
календаря можно указать диапазон дат, подлежащий экспорту.
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4.13 Синхронизации

4.13.1 Установка синхронизаций

EssentialPIM Pro поддерживает синхронизацию с рядом программ, устройств и
облачных сервисов:

Google
iCloud
Yahoo
OneMediaHub (myFUNAMBOL)
GooSync
Toodledo
Memotoo
HighRiseHQ
SyncML servers
CalDAV servers
Android OS
iOS
Outlook

Все синхронизации настраиваются при помощи мастера настройки, который
находится в меню Файл ->  Синхронизации -> Добавить синхронизацию ->
"Название синхронизации" либо можно запустить мастер синхронизации в
меню Файл ->  Синхронизации -> Мастер синхронизации. Синхронизация со
всеми онлайн сервисами настраивается по единому принципу. Рассмотрим его
основные шаги.

На первом шаге предлагается выбрать тип синхронизации.

На втором шаге предлагается ввести регистрационные данные и выбрать модули
для синхронизации. Следует иметь в виду, что в зависимости от изначально
выбранного типа синхронизации, будет доступен разный набор модулей на этом
шаге.

На третьем шаге выбирается направление синхронизации и параметры
автоматизации процесса синхронизации.

Все установленные параметры могут быть изменены в настройках синхронизации,
которые становятся доступны через меню Сервис -> Настройка -> "Название
синхронизации", либо через меню Файл -> Синхронизация -> Изменить
синхронизацию -> "Название синхронизации" после создания
синхронизации.

4.13.2 Подписка на календарь

EssentialPIM Pro позволяет добавлять внешние iCal календари посредством
подписки на них. Чтобы подписаться на календарь нужно зайти в меню Файл ->
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Подписки -> Добавить подписку на календарь (iCal).

URL - ссылка на iCal календарь
Имя - название календаря
Назначить цвет - цвет категории, которая будет присвоена событиям
календаря
Убрать - позволяет убрать/оставить напоминания и/или вложения, включенные
в события календаря
Обновлять - позволяет выставить период обновления календаря

После добавления подписки, события добавляются в EssentialPIM в виде задач
со статусом "только для чтения".

4.13.3 Android

EssentialPIM поддерживает синхронизацию с устройствами, работающими на
Android. Для этого требуется установить Android версию EssentialPIM на телефон
или планшет. Последняя версия всегда доступна в Google Play Store. 

Необходимые условия для синхронизации:

- Android 4.0.3 или выше
- Общая сеть между Android устройством и компьютером. Как правило, такая
сеть уже имеется если используется Wi-Fi маршрутизатор. Компьютер обычно
подключен к нему через кабель, в то время как мобильные устройства
подключаются через Wi-Fi. Возможно также подключение через Bluetooth, USB
кабель, либо сотовую связь.

Установка и запуск синхронизации

Настройка синхронизации осуществляется через меню Файл -> Синхронизация
-> Добавить синхронизацию -> Android.

https://play.google.com/store/apps/details?id=com.astonsoft.android.essentialpim&referrer=utm_source%3Depimwebsite%26utm_medium%3Dcpc
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Мастер установки предлагает выбор модулей для синхронизации с мобильным
устройством. Для паролей предварительно нужно установить мастер-пароль в
соответствующем модуле на Android версии EssentialPIM, затем ввести его в
данном диалоге.
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Этап сопряжения устройств. Внимательно прочитайте инструкцию в данном
диалоге и убедитесь, что все условия выполнены. Затем запустите EssentialPIM
на мобильном устройстве и выберите СинхроПК.
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Приложение автоматически произведет поиск компьютеров с запущенной
Windows версией EssentialPIM. Если такой ПК будет найден, то на экране
появится его имя. Чтобы начать синхронизацию нажмите на имя ПК. Если
компьютер не определяется, то попробуйте ручное соединение. Для этого
вызовите программное меню и выберите пункт Ручное соединение, после чего
введите IP адрес и порт предлагаемые мастером в Windows версии. 

Чтобы предотвратить несанкционированные попытки синхронизации с другими
устройствами, Windows версия EssaentialPIM запросит разрешение
синхронизации с данным конкретным устройством во время первой попытки
соединения. 

На последнем шаге мастера можно изменить название синхронизации, а также
выбрать ее  направление.
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Для запуска последующих синхронизаций необходимо:
- запустить Windows версию EssentialPIM 
- запустить Android версию EssenrialPIM, зайти в СинхроПК, а затем либо нажать
на имя компьютера (если устройства в одной сети), либо зайти в меню и
выбрать пункт Ручное соединение (если соединяетесь через сеть сотовой связи,
Bluetoth, или USB кабель)

Если вы планируете синхронизировать несколько Android устройств с
Windows версией EssentialPIM, то следует иметь в виду, что процедуру
установки синхронизации необходимо провести заново для каждого
нового устройства. 

Если соединиться не удалось, обратитесь к теме "Решение проблем".

4.13.3.1 Синхронизация через USB, Bluetooth, мобильные сети

Windows и Android версии EssentialPIM проще и быстрее всего синхронизировать
через Wi-Fi сеть. Тем ни менее, синхронизация может быть осуществлена при
помощи других способов подключения, таких как USB кабель, Bluetooth,  сети
сотовой связи и мобильной точкой доступа Wi-Fi.

Если по какой-то причине обычная Wi-Fi сеть недоступна, попробуйте
использовать один из вышеперечисленных способов. Далее рассмотрим каждый
из них подробнее.
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Синхронизация через USB кабель

1. Подключите Android устройство к ПК.
2. Зайдите в настройки телефона или планшета, затем выберите пункт Tethering
& portable hotspot (обычно он расположен в разделе Беспроводные сети) и
включите опцию USB Tethering.

3. На ПК нажмите Пуск, в командной строке введите cmd и нажмите ввод (для
пользователей Windows XP, нажмите Пуск, затем Выполнить, введите cmd и
нажмите ввод).
4. В появившемся окне введите ipconfig и нажмите ввод. Запомните или
запишите IP адрес (IPv4 Address) в разделе Ethernet adapter Local Area
Connection.
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5. Теперь запустите Windows версию EssentialPIM. Если вы синхронизировались
ранее, зайдите в меню Сервис -> Настройки, выберите синхронизацию с вашим
устройством в разделе Синхронизация. В поле IP должен отображаться IP адрес,
который вы записали.

Если это ваша первая синхронизация, тогда зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
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мастера до тех пор пока не дойдете до шага сопряжения устройств. Здесь вы
должны увидеть тот же IP адрес, что был отмечен ранее.

6. Вернитесь к EssentialPIM на Android и зайдите в раздел СинхроПК, затем
вызовите меню и нажмите пункт Ручное соединение.
7. Введите IP адрес и порт, указанные на предыдущем шаге и нажмите Connect.
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8. Синхронизация должна начаться.

Синхронизация через сети сотовой связи (3G, LTE)

В первую очередь вы должны узнать IP адрес вашего компьютера. Сделать это
можно следующим образом.

1. Воспользуйтесь поисковиком Google и введите запрос: "what's my ip".
2. Первым в списке результатов будет сайт под названием What Is My IP,
перейдите на него.
3. На странице будет написан ваш внешний IP адрес. Запишите его.

Если вы подключены к интернету через маршрутизатор, то надо зайти в его
настройки и установить переадресацию портов так, чтобы все внешние запросы
на TCP/UDP порт 21114 (порт по умолчанию а EssentialPIM), были бы направлены
на ваш ПК. Обратитесь к документации вашего маршрутизатора, чтобы узнать
как это делается, либо обратитесь в нашу службу поддержки за консультацией.

Следующим шагом убедитесь, что ваш брандмауэр позволяет Windows версии
EssentialPIM принимать входящий трафик из Интернета. Если вы используете
брандмауэр Windows, сделайте следующее:

1. Зайдите в меню Пуск -> Панель управления -> Брандмауэр Windows
2. Выберите пункт Разрешить запуск программы или компонентов через
брандмауэр Windows.
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3. Убедитесь, что для EssentialPIM поставлены галочки в обоих колонках.

Если вы используете другие фаерволы, то обратитесь к их документации.

Все приготовления закончены, теперь вернитесь в EssentialPIM на мобильном
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устройстве, нажмите СинхроПК, вызовите меню и выберите пункт Ручное
соединение. Введите внешний IP адрес вашего компьютера, который мы
определили ранее, измените порт (если необходимо) и нажмите Connect.

- Если вы синхронизировались ранее то убедитесь, что EssentialPIM запущен.
- Если вы синхронизируетесь первый раз, то зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
мастера до тех пор пока не дойдете до шага сопряжения устройств. На этом
этапе нажмите Connect в Android версии после ввода IP адреса.

Синхронизация через мобильную точку доступа Wi-Fi

При использовании этого варианта подключения, создается частная Wi-Fi сеть
между вашим компьютером и устройством на Android. В этом случае мобильное
устройство выступает в качестве маршрутизатора и компьютер подключается к
нему.

1. Зайдите в настройки телефона или планшета, затем выберите пункт Tethering
& portable hotspot (обычно он расположен в разделе Беспроводные сети) и
включите опцию Portable Wi-Fi hotspot (в некоторых случаях Android предложит
настроить точку доступа, следуйте предложенным инструкциям).

2. На компьютере найдите в списке доступных сетей вашу Wi-Fi сеть и
подключитесь. 
3. На ПК нажмите Пуск, в командной строке введите cmd и нажмите ввод (для
пользователей Windows XP, нажмите Пуск, затем Выполнить, введите cmd и
нажмите ввод).
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4. В появившемся окне введите ipconfig и нажмите ввод. Запомните или
запишите IP адрес (IPv4 Address) в разделе Wireless LAN adapter Wi-Fi.

5. Теперь запустите Windows версию EssentialPIM. Если вы синхронизировались
ранее, зайдите в меню Сервис -> Настройки, выберите синхронизацию с вашим
устройством в разделе Синхронизация. В поле IP должен отображаться IP адрес,
который вы записали.
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Если это ваша первая синхронизация, тогда зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
мастера до тех пор пока не дойдете до шага сопряжения устройств. Здесь вы
должны увидеть  тот же IP адрес, что был отмечен ранее.

6. Вернитесь к EssentialPIM на Android и зайдите в раздел СинхроПК, затем
вызовите меню и нажмите пункт Ручное соединение.
7. Введите IP адрес и порт, указанные на предыдущем шаге и нажмите Connect.
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8. Синхронизация должна начаться.

Синхронизация через Bluetooth

1. Зайдите в настройки телефона или планшета, затем выберите пункт Tethering
& portable hotspot (обычно он расположен в разделе Беспроводные сети) и
включите опцию Подключение по Bluetooth.
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2. Включите Bluetooth на компьютере и сделайте доступным ваше Android
устройство.
3. Зайдите в Пуск -> Панель управления -> Устройства и Принтеры.
Воспользовавшись кнопкой Добавление устройства, добавьте ваше мобильное
устройство и соедините с ПК.
4. Как только устройства соединены, выберите пункт Точка доступа в
контекстном меню. 
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5. На ПК нажмите Пуск, в командной строке введите cmd и нажмите ввод (для
пользователей Windows XP, нажмите Пуск, затем Выполнить, введите cmd и
нажмите ввод).
6. В появившемся окне введите ipconfig и нажмите ввод. Запомните или
запишите IP адрес (IPv4 Address) в разделе Ethernet adapter Bluetooth Network
Connection.

7. Теперь запустите Windows версию EssentialPIM. Если вы синхронизировались
ранее, зайдите в меню Сервис -> Настройки, выберите синхронизацию с вашим
устройством в разделе Синхронизация. В поле IP вы должен отображаться IP
адрес который вы записали.
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Если это ваша первая синхронизация, тогда зайдите в меню Файл ->
Синхронизация -> Добавить Синхронизацию -> Android и следуйте шагам
мастера до тех пор пока не дойдете до шага сопряжения устройств. Здесь вы
должны увидеть  тот же IP адрес, что был отмечен ранее.
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8. Вернитесь к EssentialPIM на Android и зайдите в раздел СинхроПК, затем
вызовите меню и нажмите пункт Ручное соединение.
9. Введите IP адрес и порт указанные на предыдущем шаге и нажмите Connect.

10. Синхронизация должна начаться.
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4.13.3.2 Решение проблем с Android синхронизацией

1. При попытке соединения Android с ПК возникает Ошибка соединения.

Причиной данной ошибки является неверно указанный IP адрес или порт, либо
EssentialPIM блокируется фаерволом.

Пути решения:

1. Убедитесь, что вы внимательно следовали инструкциям по настройке и
установке Android синхронизации.
2. Убедитесь, что вы используете последнюю Windows версию EssentialPIM.
Проверить наличие доступных обновлений можно через меню Справка ->
Проверить обновление.
3. Если это первая синхронизация, убедитесь что мастер установки
синхронизации в Windows версии EssentialPIM запущен и находится на шаге
сопряжения устройств. Если устройства были сопряжены ранее и это не первая
синхронизация, то запуск мастера не требуется, достаточно только запущенной
Windows версии EssentialPIM.
4. Убедитесь что брандмауэр не блокирует соединения через порт 21114 (по
умолчанию, уточните используемый порт в настройках синхронизации). Если
необходимо, измените порт на шаге сопряжения устройств во время установки
синхронизации или в настройках синхронизации.
5. Попробуйте функцию ручного соединения. Находясь в разделе СинхроПК,
вызовите меню приложения и выберите пункт Ручное соединение и введите IP
адрес и порт, предлагаемые Windows версией EssentialPIM.

2. Android EssentialPIM не видит ПК с запущенной Windows версией.
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Пути решения:

1. Убедитесь, что Windows версия EssentialPIM запущена (очень часто
пользователи просто забывают загрузить Windows версию перед
синхронизацией).
2. Если это первая попытка синхронизации, то в Windows версии должен быть
запущен мастер установки синхронизации и он должен быть на этапе
сопряжения устройств. Если устройства были сопряжены ранее и это не первая
синхронизация, то запуск мастера не требуется, достаточно только запущенной
Windows версии EssentialPIM.
3. Попробуйте несколько раз нажать кнопку сканирования.
4. Попробуйте увеличить время сканирования зайдя в Меню -> Настройки ->
СинхроПК. Мы рекомендуем установить максимальное значение. Если это решит
проблему, то постепенно уменьшайте значение пока не достигните оптимального
сочетания времени ожидания и стабильности соединения.
5. Убедитесь, что ПК и мобильное устройство находятся в одной Wi-Fi сети. Если
это не возможно по какой-либо причине, перейдите к следующему пункту.
6. Если ничего из вышеперечисленного не помогло, попробуйте альтернативные
варианты соединения, такие как соединение по USB, Bluetooth, мобильный
интернет, мобильная точка доступа Wi-Fi.

Если всё равно ничего не помогает, обратитесь, пожалуйста, в нашу службу
поддержки.

4.13.4 iOS (iPhone/iPad/iPod Touch)

EssentialPIM поддерживает синхронизацию с устройствами, работающими на
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операционной системе iOS. Для этого требуется установить iOS версию
EssentialPIM на телефон или планшет. Последняя версия всегда доступна на App
Store. Модули синхронизируются следующим образом:

Windows
EssentialPIM

          iOS EssentialPIM

Календарь    <->    Календарь (встроенный в iOS)
Дела    <->    Дела

Контакты    <->    Контакты (встроенное приложение на iOS)
Пароли    <->    Пароли

Необходимые условия для синхронизации:

- Поддерживаемые устройства: iPhone 3GS или новее, все iPad, iPOD 3 или новее
(с установленной версией iOS 5 и выше).
- iTunes установленный на ПК.
- Общая сеть между iOS устройством и компьютером. Как правило, такая сеть
уже имеется, если используется Wi-Fi маршрутизатор. Компьютер обычно
подключен к нему через кабель, в то время как мобильные устройства
подключаются через Wi-Fi. 

Установка синхронизации с iOS

Запустите мастер установки через меню Файл -> Синхронизация -> Добавить
синхронизацию -> iPhone/iPad.

Мастер установки предлагает выбрать какие модули синхронизировать с

http://itunes.apple.com/app/essentialpim/id537150179?ls=1&mt=8
http://itunes.apple.com/app/essentialpim/id537150179?ls=1&mt=8
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мобильным устройством. Для паролей предварительно нужно установить мастер-
пароль в соответствующем модуле на iOS версии EssentialPIM, затем ввести его
в данном диалоге.

Этап сопряжения устройств. Внимательно прочитайте инструкцию в данном
диалоге и убедитесь, что все условия выполнены.
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Если на данном этапе кнопка Start отсутствует, убедитесь что Windows
версия EssentialPIM находится на этапе сопряжения устройств, а также
iTunes установлен на вашем компьютере.

В момент нажатия кнопки Start, Windows версия EssentialPIM должна запросить
подтверждение соединения. Это необходимо чтобы предотвратить
несанкционированные подключения в будущем. Подтвердите запрос, после чего
синхронизация будет привязана к вашему конкретному устройству. Затем
нажмите кнопку Далее.

На последнем шаге мастера можно изменить название синхронизации, а также
выбрать ее направление.

Для запуска последующих синхронизаций нужно сделать следующее:
- запустить Windows версию EssentialPIM 
- запустить iOS версию EssenrialPIM, зайти в PC Sync и нажать Start

Если вы планируете синхронизировать несколько iOS устройств с
Windows версией EssentialPIM, то следует иметь в виду, что процедуру
установки синхронизации необходимо провести заново для каждого
нового устройства. 

Если соединиться не удалось, обратитесь к теме "Решение проблем".

4.13.4.1 Решение проблем с iOS синхронизацией

1. При запуске PC Sync в iOS версии EssentialPIM, не находится Windows
версия программы.

Пути решения:

1. Убедитесь, что вы внимательно прочитали и выполнили инструкцию по
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установке iOS синхронизации.
2. Убедитесь, что на компьютере установлен iTunes.
3. Убедитесь, что вы используете последнюю Windows версию EssentialPIM.
Проверить наличие доступных обновлений можно через меню Справка ->
Проверить обновление.
4. Если это первая синхронизация, убедитесь что мастер установки
синхронизации в Windows версии EssentialPIM запущен и находится на шаге
сопряжения устройств. Если устройства были сопряжены ранее и это не первая
синхронизация, то запуск мастера не требуется, достаточно только запущенной
Windows версии EssentialPIM.
5. Убедитесь, что iOS устройство и компьютер находятся в одной Wi-Fi сети.
6. 4. Убедитесь что брандмауэр не блокирует соединения через порт 21108 (по
умолчанию, уточните используемый порт в настройках синхронизации). Если
необходимо, измените порт на шаге сопряжения устройств во время установки
синхронизации или в настройках синхронизации.

Если ничего из вышеперечисленного не помогло, обратитесь, пожалуйста в
нашу службу технической поддержки.

4.13.5 Google

EssentialPIM Pro поддерживает синхронизацию с сервисами Google. Для
настройки синхронизации кликните Файл -> Синхронизации -> Добавить
синхронизацию -> Google.

На данном этапе нужно выбрать модули, которые требуется синхронизировать.
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Особое внимание следует уделить пунктам Заметки и Пароли, убедитесь, что
выбран необходимый параметр для заметок и введен правильный пароль для
паролей. Если будет включена синхронизация почты, то EssentialPIM также
добавит соответствующую учетную запись почты Gmail в модуль Почта.

Следующим шагом будет предложено идентифицироваться в Google и выдать
EssentialPIM'у необходимые разрешения.

На завершающем этапе можно установить направление синхронизации и
параметры автоматической синхронизации, если необходимо.

EssentialPIM Pro не синхронизирует общие и подключенные календари.
Если необходимо добавить подобные календари в EssentialPIM, то
следует воспользоваться функцией Подписки на календарь.

4.13.6 ownCloud

EssentialPIM Pro поддерживает синхронизацию с сервисами на базе ownCloud.
Чтобы синхронизировать с ownCloud, нужно установить соответствующую
синхронизацию через меню Файл -> Синхронизации -> Добавить
синхронизацию -> ownCloud.
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В поле Адрес сервера следует ввести адрес ownCloud сервера. Существует
несколько видов ссылок которые можно ввести в данное поле. В зависимости от
типа ссылки можно будет синхронизировать те или иные данные.

https://www.myserver.com/owncloud/ - так выглядит общая ссылка. По ссылке
этого типа можно синхронизировать все модули EssentialPIM, но для того чтобы
она работала, в настройках ownCloud сервера должна быть включена функция
автоопределения (auto discovery). Если синхронизация по общей ссылке не
работает, то обратитесь к документации вашего сервера за инструкциями как
включить функцию автоопределения.

https://www.myserver.com/owncloud/remote.php/caldav/ - ссылка типа CalDAV,
она позволяет синхронизировать только модули Календарь и Дела. Чтобы
получить эту ссылку, зайдите в Календарь вашего ownCloud сервера, затем
кликните на значок ссылки рядом с названием календаря, с которым требуется
синхронизировать, после чего скопируйте появившуюся ссылку в поле Адрес
сервера в диалоге мастера настройки синхронизации.
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Если требуется синхронизация только Календаря и/или Дел, то рекомендуется
использовать CalDAV синхронизацию вместо ownCloud.

https://www.myserver.com/owncloud/remote.php/carddav/addressbooks/
addressbook_name/XXXX-XXX-XXX - ссылка типа CardDAV, она позволяет
синхронизировать только Контакты. Чтобы получить эту ссылку, зайдите на
страницу Контактов вашего ownCloud сервера, затем кликните на значок
настоек (шестеренка) в левом нижнем углу окна, затем на значок ссылки рядом
с названием адресной книги, с которой требуется синхронизировать, после чего
скопируйте появившуюся ссылку в поле Адрес сервера в диалоге мастера
настройки синхронизации.

 

Если требуется синхронизация только с Контактами, то рекомендуется
использовать CardlDAV синхронизацию вместо ownCloud.

https://www.myserver.com/owncloud/remote.php/webdav/ - ссылка типа WebDAV,
она позволяет синхронизировать только Пароли и Заметки. Чтобы получить эту
ссылку зайдите в раздел Файлы вашего ownCloud сервера, затем кликните на
значок настоек (шестеренка) в левом нижнем углу окна, после чего скопируйте
появившуюся ссылку в поле Адрес сервера в диалоге мастера настройки
синхронизации.

 

Следует иметь в виду, что модули Пароли и Заметки не доступны напрямую
через интерфейс ownCloud сервера, но они могут быть синхронизированы с
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другим компьютером.

После того как первые два шага мастера пройдены, нажмите кнопку Далее
чтобы выбрать параметры синхронизации.

В дальнейшем все параметры ownCloud синхронизации можно изменить в диалоге
Сервис -> Настройки.
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4.13.7 Outlook

EssentialPIM Pro поддерживает синхронизацию с Microsoft Outlook.
Синхронизация возможна как с персональными папками (*.pst), так и с Exchange
Server. Каждый модуль EssentialPIM Pro синхронизируется с соответствующим
модулем Outlook.

Необходимые требования

Установленный MS Outlook или Exchange server 2003 / 2007 / 2010 / 2013

Установка Outlook синхронизации 

Настройка синхронизации осуществляется через меню Файл -> Синхронизация
-> Добавить синхронизацию -> Outlook.
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Мастер установки предлагает указать файл, либо профиль Exchange сервера, с
которым будет проводиться синхронизация, а также модули, подлежащие
синхронизации.
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На завершающем этапе можно переименовать синхронизацию, установить
параметры автоматической синхронизации, а также указать направление
синхронизации.

Для запуска последующих синхронизаций надо зайти в меню Файл ->
Синхронизация -> Outlook.

Так как EssentialPIM Pro является 32-битным приложением, он не может
синхронизироваться 64-битным Outlook'ом напрямую. Для
синхронизации с версиями Outlook 64-бит, мы выпустили
дополнительную бесплатную утилиту - EPIM-Outlook Sync. Она всегда
доступна для скачивания на нашем сайте.

Настройки синхронизации всегда могут быть изменены через меню Сервис ->
Настройки -> Outlook.

Данный диалог предоставляет тот же набор параметров, что и мастер установки
синхронизации, а также позволяет удалить синхронизацию, если это
необходимо, нажатием на кнопку Удалить Синхронизацию.

http://essentialpim.com/pc-version/supplementary-apps
http://essentialpim.com/get-epim
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4.14 EPIM Cloud

Теперь все данные EssentialPIM можно хранить онлайн при помощи сервиса EPIM
Cloud. Это очень удобно если требуется получить доступ к данным из разных
мест или поделиться ими с другими пользователями EssentialPIM. Доступ к
данным можно получить при помощи любого мобильного устройства или
компьютера, даже без установленного EssentialPIM, посредством веб-браузера.

Сервис EPIM Cloud разработан для безопасной синхронизации данных
EssentialPIM между Windows версиями программы. Доступ к данным
осуществляется исключительно по безопасному протоколу SSL, этот же
протокол  используется для осуществления банковских транзакций. При помощи
EPIM Cloud можно в равной степени эффективно и безопасно координировать
деятельность как с коллегами по работе, так и организовывать семейное
расписание.

4.14.1 Регистрация

Чтобы начать пользоваться сервисом, нужно пройти простую систему
регистрации. Для этого зайдите в меню Файл -> EPIM Cloud -> Войти.

Если у вас уже есть учетная запись в EPIM Cloud, то введите свои имя
пользователя и пароль и нажмите кнопку Войти. Если вы еще не пользовались
EPIM Cloud, тогда нажмите кнопку Создать аккаунт, после чего мастер
установки проведет вас через процесс регистрации.

https://cloud.essentialpim.com/
https://cloud.essentialpim.com/
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На первом шаге представляется общая информация о сервисе и его стоимость.
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На втором шаге автоматически открывается интернет броузер со страницей
заказа сервиса. После оформления заказа вым будут высланы имя пользователя
и пароль, их надо ввести в соответствующие поля  данного диалога.
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На третьем шаге предлагается установить какие модули будут
синхронизироваться с EPIM Cloud, а так же частоту синхронизации. Следует
иметь в виду, несмотря на то, что EssentialPIM  синхронизирует все данные с
EPIM Cloud, только три модуля доступны онлайн, это - Календарь, Дела и
Контакты. Другие модули, такие как Заметки и Пароли безопасно хранятся в 
облаке и доступ к ним может получить только Windows версия EssentialPIM.

Последний шаг содержит общую информацию и завершает процесс регистрации.

4.14.2 Синхронизация с EPIM Cloud

Синхронизация с EPIM Cloud может осуществляться как автоматически так и в
ручную. По умолчанию синхронизация запускается при старте программы, при
закрытии и каждый час. Вручную синхронизацию можно всегда запустить через
меню Файл -> EPIM Cloud -> Синхронизация. 

Настройки параметров синхронизации с EPIM Cloud доступны через меню Файл -
> EPIM Cloud -> Настройки, либо через Сервис -> Настройки -> EPIM Cloud.

https://cloud.essentialpim.com/epim/
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Следует иметь в виду, что так как главной задачей EPIM Cloud является обмен
данными между Windows версиями EssentialPIM, некоторые изменения внесенные
через веб интерфейс могут быть неточно отражены в Windows версии
EssentialPIM.

Чтобы приостановить использование синхронизации EPIM Cloud с текущей базой
данных, надо воспользоваться командой Выйти в меню Файл -> EPIM Cloud.
Для того, чтобы совсем прекратить синхронизацию с сервисом, надо нажать
кнопку удалить синхронизацию в диалоге настроек Сервис -> Настройки ->
EPIM Cloud.

4.15 Метки

EssentialPIM Pro поддерживает добавление меток к любым записям. Есть три
способа добавления меток. 

Первый способ - это ввести символ "#" затем любое слово введенное
непосредственно после, автоматически будет преобразованно в метку.
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После ввода символа "#" программа предлагает варианты уже имеющихся в базе
меток. Все новые метки попадают в это меню автоматически.

Второй способ это ввод меток в соответствующее поле Метки в диалоге
редактирования записи.

В этом случае не нужно вводить символ "#", достаточно просто ввести
необходимые метки через запятую. Этот способ также вызывает подсказку из
имеющихся метки, подходящих по мере ввода.

Третий способ также как и второй подразумевает использование поля Метки в
диалоге редактирования записи. Только вместо ручного ввода меток можно
выбрать необходимые метки из списка. Для этого надо нажать кнопку с тремя
точками в поле Метки.
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В данном диалоге представлен список всех меток из всех записей. Панель
инструментов этого диалога также позволяет добавлять, редактировать и
удалять метки.

Добавление меток к записям может значительно упростить поиск необходимой
информации. Строка поиска в правом верхнем углу она, а также Расширенный
поиск в меню Сервис позволяют производить поиск записей по меткам.

Список меток можно отредактировать в диалоге настроек - Сервис ->
Настройки -> Метки.

Обозреватель меток

Обозреватель меток позволяет просмотреть все метки и записи к которым они
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назначены. Левая часть окна показывает список всех меток в базе данных, а
также количество записей с каждой меткой. 

При нажатии на метку, в правой части окна отображается список записей с
выбранной меткой. Удерживая кнопки Ctrl и Shift можно выделить несколько
меток и таким образом вывести список записей соответствующих нескольким
меткам. Используя выпадающее меню Искать в, можно ограничить поиск
определенным модулем.

4.16 Расширенный поиск

Помимо строки поиска в правом верхнем углу каждого модуля, в EssentialPIM Pro
присутствует функция расширенного поиска, позволяющая создавать сложные
запросы по нескольким параметрам, а также находить и заменять текст по
заданным критериям. Открыть диалог расширенного поиска можно в меню 
Сервис -> Расширенный поиск или нажав комбинацию клавиш Ctrl+Shift+F.

Искать в - устанавливает модуль, в котором требуется провести поиск. Опция
Включая удаленные записи включает корзину в область поиска.



Работа с EssentialPIM Pro 173

© 2019 Astonsoft Ltd.

Вкладки Общие и Настройки позволяют проводить поиск используя простые и
сложные запросы.
Время - позволяет установить временные границы поиска, в течении которых
запись была создана или модифицирована. 

Вкладка Общие позволяет делать поиск по слову или фразе, вписанным в поле
Искать. Выпадающее меню Искать в полях позволяет задать область поиска до
определенных полей в записях, таких как тема, содержимое, вложения и т.д.

Вкладка Настройки позволяет создавать более сложные поисковые запросы:

Данная вкладка позволяет ввести несколько условий поиска. Для начала нужно
выбрать поле, в котором следует искать (можно выбрать поле из любого
модуля). Если требуется ограничить поиск одним модулем, необходимо выбрать
соответствующий модуль в выпадающем списке Искать в, тогда поля остальных
модулей станут неактивными. После выбора поля, нужно установить условие
поиска (равно, не равно, содержит, не содержит). Как только текст запроса,
область поиска и условия сформированы, можно запустить поиск нажав кнопку 
Найти. 

Если требуется добавить еще одно или несколько условий, нужно нажать
кнопку со знаком плюс в конце строки запроса и ввести необходимые условия.
Если нужно удалить одно из условий, нажмите кнопку со знаком минус. Для
быстрого удаления всех условий, нажмите кнопку Очистить.

Опции Для всех указанных полей и Для любого указанного поля
устанавливают строгость поиска. В первом случае будут найдены записи
отвечающие всем добавленным условиям, во втором - хотя бы одному из
условий.

Сохранить/Загрузить - данная функция позволяет сохранить запрос и
использовать его повторно позже.
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Вкладка Заменить позволяет выполнить поиск и замену фрагмента текста.
Замену можно повести как по всей базе данных так и в определенных модулях.

Ctrl+Shift+F - горячее сочетание для вызова диалога расширенного
поиска.

4.17 Работа с напоминаниями

Для встреч и дел можно добавить напоминания на определенное время. Как
только напоминание срабатывает, появляется следующий диалог:

Напомнить - откладывает выделенное напоминание на определенный период
времени указанный в выпадающем меню рядом с кнопкой.
Закрыть все - закрывает все активные напоминания.
Закрыть - закрывает выделенное напоминание(я).
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Перейти к записи/Показать - переходит в модуль Календарь или Дела и
фокусируется на выделенной записи / открывает диалог редактирования
выделенной записи.

Напоминания можно отсортировать по любому из столбцов в диалоговом окне.
Для этого надо кликнуть левой кнопкой мыши по заголовку столбца. Удерживая
кнопку Ctrl на клавиатуре, можно сортировать по нескольким столбцам.

Открыть закрытый диалог с напоминаниями можно через меню Вид ->  Окно
напоминания.

4.18 Категории

Категории в EssentialPIM Pro являются удобным инструментом организации
событий. Они позволяют наглядно разделять записи на различные группы. В
настоящее время категории могут быть присвоены записям модулей Календарь
и Дела.

Присвоение категории

Присвоить категорию можно как новым, так и уже созданным записям. Для этого
в окне редактирования дела или задачи нужно выбрать необходимую категорию
из выпадающего списка Категория.

Данный список предлагает выбор из набора категорий, созданных в EssentialPIM
Pro по умолчанию. 

Присвоить категорию можно также не открывая окно редактирования
записи. Для этого нужно выбрать запись и присвоить ей категорию
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через меню Правка -> Категория

Редактирование категорий

С увеличением количества задач или дел могут понадобиться новые категории,
либо изменение имеющихся. EssentialPIM Pro позволяет делать и то и другое.
Для этого нужно выбрать пункт Выбор категории из списка категорий. Это
откроет диалоговое окно редактирования категорий.

Добавить - создает новую категорию.
Удалить - удаляет выбранную категорию.
Вверх/Вниз - позволяют настроить порядок, в котором категории будут
выстроены в выпадающем списке.
Цвет - позволяет выбрать цвет для выбранной категории.

Если кнопка с тремя точками отсутствует, значит вы либо используете
бесплатную версию (Free), либо бизнес версию и у вас нет прав для
редактирования категорий. В первом случае установите Pro версию, во
втором - обратиться к администратору для расширения прав доступа,
после чего функция станет доступна.
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4.19 Вложения

Каждая запись в EssentialPIM Pro, будь то встреча, дело, заметка или контакт,
может включать в себя вложения. Вложения - это или файлы или ссылки на
файлы.

Чтобы прикрепить файл к записи, нужно открыть запись и нажать кнопку со
скрепкой на панели инструментов заметки, либо кнопку Прикрепить файл в
области вложений, затем указать требуемый файл в проводнике. После чего
появится диалог добавления файла. 

Добавить файл - добавит копию файла в базу данных программы, при этом
файл на жестком диске и прикрепленный файл не будут иметь связи.
Добавить ссылку на файл - создаст ссылку на файл, находящийся на жестком
диске, при этом не увеличивается размер базы. При перемещении
прикрепленного файла (или удалении) он станет недоступным из EssentialPIM
Pro.

Отображение вложений

Вложения могут отображаться в двух режимах - одной строкой в нижней части
окна с информацией о записи либо отдельной закладкой.
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Кнопки с правой стороны на панели вложений позволяют переключаться между
этими двумя режимами. Режим вкладки поддерживает различные виды
отображения вложений, такие как таблица, список, большие и маленькие
иконки.

Добавить вложение можно также перетащив файл, либо группу файлов
из проводника Windows в окно вложений, удерживая левую кнопку
мыши.

Управление вложениями

Данный инструмент позволяет управлять как вложенными файлами, так и
записями, содержащими вложения. Это также удобный инструмент для контроля
за размером базы данных, так как позволяет легко найти любые вложения и
удалить ненужные. Вызвать диалог управления вложениями можно через меню 
Сервис -> Управление вложениями, либо нажав кнопку Управление
вложениями области вложений любой записи EssentialPIM Pro.
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Диалог управления вложениями содержит две вкладки:

1. Записи ЕПИМ - эта вкладка позволяет просматривать вложения относительно
записей. Список слева показывает все записи в базе, которые содержат
вложения, а список справа показывает вложения, содержащиеся в выбранной
записи. 

Здесь вложения можно открыть, добавить новое, сохранить на жесткий диск,
либо удалить. Все перечисленный команды доступны через контекстное меню по
правой кнопке мышки.

2. Файлы - эта вкладка, наоборот, позволяет просматривать записи
относительно имеющихся в базе вложений. В левом списке показаны все
вложения в базе, а справа показано к каким записям они прикреплены.

Shift+Ctrl+A - горячее сочетания для быстрого доступа к диалогу
управления вложениями.

4.20 Проверка орфографии

EssentialPIM Pro имеет встроенную функцию проверки орфографии. Окно
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проверки можно вызвать либо клавишей F7, либо через меню Сервис ->
Проверка орфографии.

Диалог проверки орфографии предлагает следующие функции:

Пропустить - игнорирует предлагаемое исправление.
Пропустить все - игнорирует все аналогичные слова.
Заменить - заменяет слово с ошибкой на предложенный вариант.
Заменить все - заменяет все аналогичные слова на выбранный вариант.
Добавить - добавляет неизвестное слово в словарь.
Словари - позволяет включать/отключать словари, скачивать новые.

Настройка проверки орфографии

Настройки проверки орфографии можно открыть через меню Сервис ->
Настройки -> Орфография.
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Здесь можно указать в каких модулях проверять орфографию в автоматическом
режиме (неправильные слова будут подчёркнуты), а также включать/отключать
установленные словари, а так же добавлять новые.

По умолчанию устанавливается только английский (US) словарь, но можно
установить любые дополнительные словари. Для этого надо включить галочку у
необходимого словаря в списке Доступные словари и нажать кнопку
Выполнить. В процессе установки ЕПИМ может попросить предоставить прав
администратора, что следует подтвердить. Как только установка закончится,
новые словари сразу становятся доступными.
Чтобы удалить словарь, надо снять галочку у календаря из списка Доступные
словари и нажать кнопку Выполнить.
Чтобы просто временно отключить словарь, снимите галочку у календаря в
списке Установленные словари.

4.21 Работа с Dropbox

EssentialPIM Pro позволяет хранить файл базы данных в Dropbox. При
использовании этой функции файл храниться в "облаке" и к нему можно
получить доступ из любого места. Эту функцию можно также использовать как
дополнительное резервное копирование, либо для переноса данных на другой
компьютер.
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Следует иметь в в виду, что мобильные версии EssentialPIM для Android
и iOS не могут работать с базой данных, расположенной в Dropbox.

Создание нового файла в Dropbox

Перейдите в меню Файл -> Новый -> Файл ЕПИМ в Dropbox, после чего
откроется мастер настройки Dropbox, который поможет вам установить
необходимые параметры.

На первом шаге необходимо разрешить доступ к вашему Dropbox аккаунту. Для
этого нажмите кнопку Разрешить, затем подождите когда загрузится интернет
страница Dropbox с запросом на предоставление доступа. Подтвердите запрос,
нажав кнопку Можно. В результате будет создана специальная папка в Dropbox
где EssentialPIM будет хранить свои файлы. После этого вернитесь к мастеру
установки и нажмите кнопку Вперед.
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На втором шаге введите имя создаваемой базы данных. Можно либо ввести свое,
либо оставить предложенное мастером. В итоге EssentialPIM создаст и отправит
новый файл в следующую папку в Dropbox: Apps\EssentialPIM Databases\.

Следует иметь в виду, что EssentialPIM не работает с базой данных
расположенной в Dropbox напрямую. Программа создает временную
копию локально и загружает ее назад в Dropbox по окончании работы.
При следующем старте EssentialPIM сравнивает локальную копию файла
с копией в Dropbox и открывает последнюю версию.

Размещение существующей базы данных в Dropbox

В случае, когда база данных уже создана и вы хотите поместить её в Dropbox,
перейдите в меню Сервис -> Настройки -> Dropbox.

В диалоге настроек Dropbox нажмите кнопку Выполнить, после чего появится
Мастер настройки Dropbox, который позволит быстро осуществить перенос.
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Открытие базы, размещенной в Dropbox

Если есть необходимость открыть ранее сохраненную в Dropbox базу данных,
зайдите в меню Файл -> Открыть в Dropbox, после чего откроется диалог со
списком EssentialPIM файлов, взятых из папки Apps\EssentialPIM Databases\ с
вашего Dropbox аккаунта.

В случае если данная копия EssentialPIM Pro соединяется с Dropbox первый раз,
появится специальное окно авторизации. Следуйте инструкциям на экране для
предоставления доступа к вашей учетной записи Dropbox. 

Прекращение использования Dropbox

Если хранить данные в Dropbox больше не требуется, то перейдите Сервис ->
Настройки -> Dropbox.

В диалоге настроек нажмите кнопку Выполнить, после чего EssentialPIM
скачает файл на компьютер и удалит копию из Dropbox.
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4.22 Отправка по E-mail

EssentialPIM Pro позволяет отправить любую запись или группу записей по
электронной почте. Чтобы это сделать надо выделить необходимые записи и
вызвать контекстное меню правой кнопкой мыши и выбрать команду Отправка
по E-mail.

Это создаст письмо в котором выбранные записи будут добавлены как вложения.
Встречи и дела прикрепляются в виде iCal (*.ics) файлов, а контакты как vCards
(*.vcf).
При отправке заметок, текст заметки вставляется в тело письма.

4.23 Безопасность

В EssentialPIM Pro аспекту безопасности уделено особое внимание. База данных
может быть зашифрована различными алгоритмами шифрования, например,
одним из самый стойких AES (Rijndael) 256bit, а синхронизация со всеми онлайн-
сервисами проходит по SSL протоколу. Таким образом, данные в безопасности,
как на вашем компьютере, так и при синхронизациях.

Установка пароля на базу данных

Добавить парольную защиту можно через меню Файл -> Защита базы данных.
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В данном диалоге нужно ввести пароль дважды и выбрать алгоритм шифрования.

После того, как база будет зашифрована, пароль будет запрашиваться при
каждой попытке открыть базу данных.
Чтобы изменить, либо снять пароль, нужно зайти в меню Файл -> Парольная
защита, после чего программа запросит пароль и после успешного ввода
откроет диалог редактирования пароля.

Теперь можно либо изменить пароль, введя новый, либо удалить парольную
защиту нажав кнопку Удалить.
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Настройка парольной защиты

База данных может быть закрыта паролем не только в момент открытия, но
также и в ряде других случаев, которые можно настроить через меню Сервис -
> Настройки -> Защита.

Настройки разбиты на три основных раздела:
1. Эти параметры касаются записей со статусом "Личное". Личные записи могут
быть скрыты, а также включены либо исключены из процессов обмена данными,
таких как экспорт и синхронизации.
2. Отвечает за блокировку модулей после сворачивания окна программы.
Отмеченные модули будут заблокированы при сворачивании окна программы.
3. Дополнительно блокирует выделенные модули. Выпадающее меню позволяет
указать через какое время после  открытия базы данных блокировать
отмеченные модули.

Также скрывать личные записи - данная опция действует на
соответствующие записи, при попытке отобразить личные записи будет
запрашиваться пароль.

Очищать список загруженных баз при выходе - удаляет список последних
использовавшихся файлов в меню Файл.
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4.24 Перекрестные ссылки

EssentialPIM позволяет ссылаться с одних элементов на другие. Ваша задача
может ссылаться на Контакты, с которыми вы встречаетесь и на Дела, которые
нужно выполнить до встречи. Помимо внутренних перекрестных ссылок можно
также добавить интернет ссылки и ссылки на файлы на жестком диске.

Ссылка может быть добавлена в текстовые поля модулей Календарь, Дела,
Заметки, Контакты, Пароли. Для добавления ссылки, нажмите кнопку
Вставить гиперссылку на панели инструментов.

Ссылка на запись - создает ссылку на любую запись из EssentialPIM Pro.
Ссылка в Интернет - создает ссылку на страницу в Интернете или на адрес
электронной почты.
Ссылка на файл - создает ссылку на файл на жестком диске.
Текст - здесь можно ввести текст, который будет отображаться в виде ссылки
Ссылка на запись (Адрес, либо Имя файла) - название данного поля зависит
от выбранного типа гиперссылки.
Обзор - позволяет указать объект ссылки. В случае ссылки на файл это будет
стандартный проводник Windows, в случае же ссылки на запись в EssentialPIM,
откроется диалог со списком всех записей базы данных.
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Список записей в базе представлен в виде проводника. Слева в виде дерева
представлен список всех модулей и подчиненных уровней, таких как списки дел,
структуры заметок, группы контактов и паролей. Для быстрого выбора
необходимой записи в рамках выделенного уровня, можно воспользоваться
строкой поиска Найти.

Список также может быть отсортирован по любому из полей. Для этого надо
щелкнуть левой кнопкой мыши по заголовку столбца по которому требуется
провести сортировку.

Нажав кнопку Подробнее, можно вызвать диалоговое окно редактирования
выбранной записи.

Еще один способ ввода ссылки на запись в базе данных, это ввести символ "@"
и начать вводить имя записи. По мере ввода EssentialPIM предложит подходящие
записи из базы.

У каждой записи есть закладка Связанные записи, в которой можно
посмотреть какие записи имеют ссылки на данную запись. Данная вкладка
находится в диалоге редактирования каждой записи. 
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Для быстрого создания ссылки на запись внутри базы можно
воспользоваться функцией Копировать как Ссылку. Для этого
следует вызвать контекстное меню записи, на которую требуется
сделать ссылку и выбрать опцию Копировать как Ссылку. Это
поместит ссылку в буфер обмена. Затем ее можно  вставить из буфера
обмена, воспользовавшись стандартной функцией Вставить из
контекстного меню, либо горячим сочетанием клавиш Ctrl+V.
Скопированную таким образом ссылку можно использовать не только
внутри программы, но и во внешних приложениях. При клике на такую
ссылку будет загружен EssentialPIM Pro и откроется требуемая запись.

Есть несколько способов открытия ссылки:
- клик левой кнопкой мыши (или Ctrl + левый клик, в зависимости от
того где находится ссылка) открывает целевой объект в отдельном окне
- Alt + левый клик открывает целевой объект в главном окне.

4.25 Использование прокси сервера

Если ваше подключение к Интернету использует прокси сервер, то для
осуществления синхронизации с онлайн сервисами и получения почты
потребуется указать параметры прокси сервера. Настройки прокси доступны
через меню Сервис -> Настройки -> Прокси сервер.
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Прокси сервер - включает/отключает использование прокси сервера.
Тип - указывается тип сервера HTTP/HTTPS, SOCKS4, SOCKS5.
Сервер требует идентификации - заполняется только если прокси сервер
требует аутентификацию.

5 Покупка EssentialPIM Pro

Пробная версия EssentialPIM Pro является полнофункциональной, но работает
только 30 дней. Станьте зарегистрированным пользователем программы и
получите право бессрочного пользования купленной вами версией EssentialPIM
Pro. В дополнение к этому, вы получите бесплатные обновления на один год.

Купить EssentialPIM Pro и EssentialPIM Pro Бизнес 

EssentialPIM Pro (Обычная/Переносная) 1 900 руб. 
EssentialPIM Pro бессрочная лицензия2 900 руб. 
EssentialPIM Pro Бизнес 2 900 руб. 
EssentialPIM Pro Бизнес бессрочная лицензия 4 900 руб.

Обновление лицензии EssentialPIM Pro

Обновление до вечной лицензии EssentialPIM Pro 1 900 руб. 
Обновления на год для EssentialPIM Pro 900 руб.

Обновление лицензии EssentialPIM Pro Бизнес

Обновление до бессрочной лицензии EssentialPIM Pro Бизнес 2 000 руб. 
Обновления на 1 год для EssentialPIM Pro Бизнес 1 000 руб.
Апгрейд EssentialPIM Pro до версии Бизнес 1 000 руб.

https://store.payproglobal.com/checkout?products[1][id]=40028&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47257&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47251&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47252&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47248&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47253&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47254&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47255&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
https://store.payproglobal.com/checkout?products[1][id]=47256&page-template=10364&language=ru&billing-country=RU&show-popular-methods-only=false
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6 Поддержка

6.1 ЧАВО (на Английском)

6.1.1 General

Q: How to make EPIM to start with another module?   
A: If you'll disable "Start with EPIM Today" in Tools -> Options -> EPIM Today than
EPIM will start with the last used module.  
 
Q: How to find my database file?   
A: EPIM stores all data in .epim database files. The default paths for EPIM databases
are:
C:\Documents and Settings\User Name\Application Data\EssentialPIM - for XP
C:\Users\User_name\AppData\Roaming\EssentialPIM - for Vista, 7 and 8
If you can't find it anyway than try to search *.epim files on your computer.
 
Q: I've tried your Free version and then purchased Pro but all my data was
lost after installation. How to recover it?   
A: EPIM stores all data in .epim database files. You only need to open (File -> Open)
your old base in EPIM Pro version. 
The default paths for EPIM Free databases are:
C:\Documents and Settings\User Name\Application Data\EssentialPIM - for XP
C:\Users\User_name\AppData\Roaming\EssentialPIM - for Vista and Seven
If you can't find it anyway than try to search *.epim files on your computer.
 
Q: I've downloaded your EPIM but the installer would not work. What should I
do?   
A: This is because of incomplete download. Try to redownload instalation file again.
If it still tells that file is corrupted than most probably your browser or provider
cached file and every time you try to re-download it gives you cashed incomplete file
again. Try to clear browser cache or download with any download manager.
 
Q: Will my data preserve if I'll upgrade my EPIM Free to Pro?   
A: Yes, but you'll need to open (File -> Open) your old base in Pro version manually.
The default paths for EPIM Free databases are: 
C:\Documents and Settings\User Name\Application Data\EssentialPIM - for XP
C:\Users\User_name\AppData\Roaming\EssentialPIM - for Vista, 7 and 8
If you can't find it anyway than try to search *.epim files on your computer.
Note, if you upgrading from Pro trial to paid version then no need to do something.
EPIM will pick up file automatically.
 
Q: Is it possible to run EPIM on Mac OS (Linux)?   
A: Unfortunately no. Only Windows version available for now. 
 
Q: I want to install EPIM to my smartphone. What version should I buy?   
A: Regular EPIM Pro version runs on Windows desktop only and syncs with Windows
Mobile, Android, iOS and Palm devices. Add synchronization under "File -> Add
Synchronization". We also have Android version with To Do, Passwords and Notes
module. It's available on Google Play
 

https://play.google.com/store/apps/details?id=com.astonsoft.android.essentialpim
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Q: How can I access .epim database directly?   
A: EPIM uses Firebird database engine. You can access database directly using any
Firebird database manager. For example: http://www.mitec.cz/ibq.html Please note
that you should understand how to work with database, otherwise data will be lost.
Default l 
 
Q: My database size is 1,5Mb but backup file size is 350kb? Does backup
stores all my data?   
A: Don't worry all your data is stored in backup. It is compressed. 
 
Q: I have bought other computer but now I want to transfer all my EPIM
program and data to this new computer - can you explain to me how to do
this?   
A: You should install EPIM to a new computer and register it with your license name
and key. Then you should transfer your database and open it in EPIM (File -> Open).
You can always download EPIM installation file from our site: http://
www.essentialpim.com 
 
Q: How can I transfer data to EPIM from another PIM?   
A: Data could be transferred via supported by EPIM formats only. You can find all
supported formats in File -> Import menus. 
 
Q: How to sort records by...   
A: All EPIM items could be sorted by any field. Click on field caption in order to sort
by it. Holding Ctrl button will allow to sort by several fields. 
 
Q: Is there a way to export in one file all EPIM settings?   
A: Yes, all settings are stored in EPIM.ini file which is stored here: C:\Documents and
Settings\User Name\Application Data\EssentialPIM - for XP C:\Users\User_name
\AppData\Roaming\EssentialPIM - for Vista, 7 and 8. Portable version stores this file
in its program  
 
Q: I purchased the EssentialPIM Pro and I would like to know whether after
one year, will I have to buy a new license?
A: You'll need to renew your license for 50% of its cost in order to receive further
upgrades for additional year. If you won't want to sign up for further upgrades then
you'll be able to use your current (for that moment) version for a lifetime.  
 
Q: Can I install EPIM to my notebook and on my PC?   
A: Yes, license agreement allows you to install EPIM on two computers belonging to
you (desktop and notebook). 
 
Q: How to change/remove database password?   
A: Do the following to remove or change password: 1. Go to File -> Password
protection 2. Enter your password and press OK 3. Press Clear or enter new
password in appeared dialog  
 
Q: EssentialPIM can not open database from a shared disk   
A: EPIM Pro can't open database file over the network directly. It connects via
Firebird server. Regular EPIM Pro version allows one user connection to database.
Please refer to Networking topic for more details.
 
Q: Is it possible to host EPIM database online?   

http://www.mitec.cz/ibq.html
http://www.essentialpim.com
http://www.essentialpim.com
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A: Yes, absolutely. You need "Firebird database hosting". Just one example: http://
www.techsol-host.com/firebird.php You will be able to connect to your database
from anywhere. 
  
Q: I've forgotten my database password. How can I recover it?   
A: Unfortunately it's not possible to recover database password. 
  
Q: How to print Calendar in color?   
A: You should enable corresponding option it Print options dialog (File -> Print). Note,
this feature is available in Pro version only. 

Q: After upgrade, will my data be preserved?
A: Yes, your data is stored in *.epim file and will be automatically converted to the
new version format.

Q: How do I restore Backups?
A: Backups are just *.epim files, named "file name_backup_year_month_day_time".
They can be opened from within EPIM using File -> Open menu.

Q: This morning I opened PIM and all my entries had disappeared. What do I
do now? 
A: Please search your computer for *.epim files, most probably you have opened a
wrong *.epim file or created a new one, empty.

Q: Do I need to purchase the extended download service?
A: No you do not. You will always have full access to the latest releases. If you lose
your registered version by for example, reformatting your hard drive, you can always
visit the Download section on the web site and get the latest release there free of
charge. Once the program is downloaded, simply register it with your license details.
In order to safely remove extended download service from the cart (upon
purchasing) click on the corresponding checkbox and then click the "Update" button
on the order form. 

Q: Can I request a feature?
A: Yes, of course. We try to really attentively listen to the users- that's how
EssentialPIM is being developed. Please post your request here: Online Support
Forum -> Suggestions.

Q: Is EssentialPIM Pro translated to ... language?
A: For a current list of translations, please check here. If you do not see
EssentialPIM translated to your language - please feel free to do it, it is really easy.
Just visit the Translators' Page.

Q: Can I help make EssentialPIM Pro better?
A: Yes, you can translate EssentialPIM Pro into your native language or suggest a
feature. 

Q: In the database manager window is a function to check for invalid file links
in the database, does this only apply to attachments or does it also  check for
invalid links in notes?
A: It applies to attachments only. 

Q: EPIM became very slow. How to boost performance?

http://www.techsol-host.com/firebird.php
http://www.techsol-host.com/firebird.php
http://www.essentialpim.com/get-epim/dictionaries
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A: First, empty trash and run optimization under "File -> Database management".
If it won't help then create a new database under "File -> New -> EPIM Data File"
and save it. Then sync it with your file using EPIM Synchronizer tool which could be
downloaded from our site - http://www.essentialpim.com/get-epim Then open newly
synced file under "File -> Open"

Q: I have created a password, but how can I change my password? 
A: You need to go to File -> Password protection, erase asterisks and enter your
new password. 

Q: Password protection or Optimization option is not active
A: EPIM can't utilize database management tools while mail send/receive processes
are active. Disable "Check mail on start" option and restart EPIM. Password
protection and Optimization options will be active then.

Q: How to delete/archive old records from database?
A: We have a special tool for this - EPIM Archiver/DupeRemover. It can delete or
archive items older then particular date. Tool available from our download page - 
http://www.essentialpim.com/get-epim 

6.1.2 Calendar

Q: How to add national holidays to calendar?   
A: You can import holidays as iCal (.ics) calendar which could be downloaded from
Internet. 
 
Q: How to generate a list of upcoming birthdays and/or a list of all birthdays.   
A: You should switch calendar to Table view, filter tasks according to Birthday
(Holiday) category and set date ranges. You'll get your list then. 
 
Q: Is there a possibility to make a text search, among all appointments
scheduled in the current period?   
A: Yes, switch to Table view, then you can make search by keywords then set date
limits. Or use Advanced search.

6.1.3 Notes

Q: Internet links doesn't work in Notes. The link become blue when I enter it,
but nothing happens when I Click on it.   
A: It works the same as in MS Word. You should click links holding Ctrl button. 

6.1.4 Contacts

Q: How can I delete unnecessary fields from contacts?   
A: Open any contact, select the field you want to delete and press "Delete field"
button. 
 
Q: Is it possible to add additional anniversaries to contact i.e. wife’s birthday
or any other?   
A: Yes, open any contact and press "Add field" button then set Date Field type.
EPIM will create recurring task for this event the same as for birthdays then. 
 

http://www.essentialpim.com/get-epim
http://www.essentialpim.com/get-epim
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Q: How to add/remove columns to display in Contacts view?   
A: Right-click columns caption and choose fields to display. 
 
Q: How can I add/edit field(s) in contacts?   
A: Open any contact and press “Add field” or select a field and press “Edit field”
correspondingly. 
 
Q: How can I change fields order in Contacts?   
A: Just drag them in preferred order with left mouse button. 
 
Q: Some fields are not listed in Contacts table (main view) and some are not
necessary. How to set to display needed fields?   
A: Right-click on field name caption and choose fields to display from context menu. 
 

6.1.5 Mail

Q: "Socket Error # 10060 Connection timed out" error
A: Make sure that all servers setting were set correctly under "Tools -> Account
Settings -> Edit -> Servers Settings"
If you are not sure about what to enter then login to your account via web interface
and refer to Help area. Search for POP3/IMAP (for incoming mail) and SMTP (for
outgoing mail) settings through FAQs.

Q: How to make mail available offline for IMAP accounts?
A: IMAP accounts download headers only by default. Press "Manage Folders" button
from Actions panel and choose what folders to download fully. Those folders
contents will be available offline then.

6.1.6 Network

Q: We've ordered additional Network license(s) but we can't access to
database. It says that we need network license. What to do?   
A: Send us all your order ID's we'll send you a proper key then. 
 
Q: I am trying to log into the program, but it only lets me login with the
SYSDBA. How can I login with another user name?   
A: You should create user account(s) to login under another user. Here are the
steps: 1. Login as SYSDBA. 2. Go to Tools -> Users. 3. Create an account(s) you
need.  
 
Q: Is there a manual or installation instructions for EssentialPIM Pro Network
available?   
A: Here goes the link to video tutorial about establishing network connection: http://
www.essentialpim.com/?r=support&pr=tutor It should help you. If you'll encounter
problems anyway let us know on which step you have problem. You can also refer to
Networking topic of this manual.
 
Q: When I’m trying to open database I get this error message: “You need
network license to connect to EPIM server”   
A: You’ve exceeded amount of simultaneously connected users to database. Regular
EPIM Pro version allows one user connection over the network. For more connections

http://www.essentialpim.com/?r=support&pr=tutor
http://www.essentialpim.com/?r=support&pr=tutor
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you'll need network licenses. The number of licenses should equal the number of user
installations in your EssentialPIM Network. I.e. if you have 10 installations, you need
to purchase 10 licenses. Note, only EPIM installations need license, server can run
without EPIM installation.
 
Q: I’ve purchased Network license for each workstation, firebird is running on
the server but when I’m trying to connect to database this message appear:
“You need network license to connect to EPIM server”   
A: Make sure that exceeding EPIM copy is not connected to database. Possible
someone run EPIM client twice. Check hidden items in system trays on each
workstation.
 
Q: I can not connect to my database over the Network.   
A: Most probably firewall is to blame. Following ports need to be open to allow EPIM
Clients to communicate to the server:
- on Server machine for fbserver.exe:
       - incoming: 3050 and 3051 
       - outgoing : whole range (fbserver uses random range of ports to communicate
events)
- on Client machine for EssentialPIM.exe:
       - incoming: whole range
       - outgoing: 3050 and 3051
 
Q: EPIM is slow over the Network   
A: If your Network is fine, please make sure that the database is not being copied by
some backup applications (or Windows built-in tools) while Network users connect to
it. 
 

6.1.7 Potable version issues

Q: I want to upgrade my U3 version but can't find it on your download page?   
A: Sorry, U3 version won't be supported anymore. You can install version for regular
drives. Download the ZIP file and unzip it on your flash drive and run
EssentialPIM.exe. Launchpad icon could be added with this tool - http://
www.softpedia.com/reviews/windows/Shortcut-Creator-4U3--Review-76269.shtml
 
Q: My EPIM is very slow on my USB stick. How can I boost it up?   
A: EPIM speed depends on your USB stick speed. Try to empty Trash and delete old
unnecessary items. You can also try to Optimize database (File -> Database
management -> Optimize). These measures should boost performance. Try also to
reformat USB drive.
 
Q: Can I use portable EPIM as desktop EPIM?   
A: This is not recommended, although you can try. Just unzip non-U3 version to your
hard drive and run EssentialPIM.exe from program folder. 
 
Q: "Cannot write key information" error when trying to enter key?   
A: This happens on some portable versions when user wants to apply new license
key. Prior to applying new code, exit EPIM, erase "EssentialPIM.ini" file which is in
EPIM installation directory. Start EPIM. It will accept key.  
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Q: EPIM asks for my license code each time I open the program from a
different computer. How to prevent this? 
A: It is because you've installed Desktop version instead of Portable one. Download
correct version from our web site please - http://www.essentialpim.com/get-epim 
 

6.1.8 Synchronization issues

Q: Is it possible to sync Desktop and Portable calendar?   
A: Yes, we have a special EPIM Synchronizer tool for this. It's available from our
download page - http://www.essentialpim.com/get-epim 
 
Q: How can I sync only specified items?   
A: You can use "private" flag for this. EPIM can include/exclude private items to/from
synchronization. You can exclude private items from synchronization by unchecking
corresponding option in Tools -> Options -> General dialog. "Private" flag can be set
via context menu for any item.
 
Q: Why Outlook synchronization syncs everything except mail?
A: EPIM doesn't sync mail with Outlook. Mail sync directly with mail server if you use
IMAP account. Create IMAP accounts in both EPIM and Outlook and your mail will be
always synced.

Q: I've got duplicates after synchronization/import. How to remove them?
A: We have a special tool for this - EPIM Archiver/DupeRemover. It's available from
our download page - http://www.essentialpim.com/get-epim 

6.1.9 Ordering and upgrade problems

Q: How can I get an invoice for my order?   
A: You can always get an invoice here: https://www.regnow.com/order_lookup.html 
 
Q: Still not received my CD, has it been shipped?   
A: Receiving a CD might take some time - up to a month, please be patient. In case
you do not get it after a month, please contact us. 
 
Q: I've ordered EssentialPIM recently but didn't received my license key.   
A: The key is sent automatically upon funds receipt. It means that if you paid by
card you should receive your license within minutes. For some products, automatic
message is sent, saying that the key will be sent within 2 working days. In case you
do not get it after few days, please contact us. 
 
Q: "Cannot write key information" error when trying to enter key?   
A: This happens on some portable versions when user wants to apply new license
key. Prior to applying new code, exit EPIM, erase "EssentialPIM.ini" file which is in
EPIM installation directory. Start EPIM. It will accept key. 
 
Q: What's your upgrade policy for EssentialPIM Pro?
A: By becoming a registered user you can use EssentialPIM Pro version you
purchased forever. In addition, you are entitled to free updates for one year starting

http://www.essentialpim.com/get-epim
http://www.essentialpim.com/get-epim
http://www.essentialpim.com/get-epim
https://www.regnow.com/order_lookup.html


Поддержка 199

© 2019 Astonsoft Ltd.

from your purchase date. 

Q: License expired after upgrade. Why?
A: According to our upgrade policy regular licence allows to upgrade for one year
after purchase date. If you got this message then it means your free upgrades
period has over. Now you need to order an upgrade (it costs 50% of full license
price) - http://www.essentialpim.com/buy. Or you can back to previous version -
http://www.essentialpim.com/vv/. If you are not sure what version you entitled for
then forward your order ID or email used for ordering to support. 

6.2 Обновление

Для проверки наличия новой версии программы, запустите EssentialPIM Pro и
зайдите в меню Помощь -> Проверить обновление.

Вы также всегда можете скачать последнюю версию программы вручную с
нашего официального сайта - www.essentialpim.com/ru/get-epim

6.3 Pешение проблем

При возникновении проблем с EssentialPIM Pro, пожалуйста, следуйте
следующим шагам для поиска решения:

Убедитесь что у вас установлена последняя версия программы
Посетите наш форум, возможно, решение уже найдено www.essentialpim.com/
forum
Если решение проблемы так и не было найдено, не стесняйтесь, пишите в
нашу службу технической поддержки (на русском общаемся с удовольствием)
- epimsupport@essentialpim.com

7 Контакты

Наши контакты:

E-mail адреса
Общая информация: epiminfo@essentialpim.com
Продажи: epimsales@essentialpim.com
Техническая поддержка: epimsupport@essentialpim.com

Тел./Факс (Обратите внимание, мы не оказываем тех. поддержку по телефону)
Факс: (+372) 650-79-37
Телефон: (+372) 5192-79-21

Почтовый адрес
Астонсофт ТОО (Astonsoft OU)
Лаки 9А
10621 Таллин

http://www.essentialpim.com/buy
http://www.essentialpim.com/vv/
http://www.essentialpim.com/ru/get-epim
http://www.essentialpim.com/forum
http://www.essentialpim.com/forum
mailto:epimsupport@essentialpim.com
mailto:epiminfo@EssentialPIM.com
mailto:epimsales@EssentialPIM.com
mailto:epimsupport@EssentialPIM.com
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